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 1. Introduction 
 

The Debris Assessment Software (DAS) is provided by the NASA Orbital Debris Program Office 

as a means of assessing, during the planning and design phase, space missions’ compliance with 

NASA’s requirements for reduction of orbital debris. 

 

 

1.1 Scope and Limitations 
 

DAS is designed to assist NASA programs in performing orbital debris assessments (ODA), as 

described in NASA Technical Standard 8719.14C, Process for Limiting Orbital Debris. The 

software reflects the structure of the Standard and provides the user with tools to assess compliance 

with the requirements. If non-compliant, DAS may also be used to explore debris mitigation options 

to bring a program within requirements. 

 

While DAS provides many functions useful in performing ODAs, its list of features is not 

exhaustive. Some analyses (e.g., hardware reliability, space tethers) are better done outside DAS. 

The user should remember that DAS is a software tool, while the NASA Technical Standard 

8719.14C contains the actual mission requirements. 

 

DAS 3.2 will assess payloads operating from the year 2016 to 2050, and objects in orbit (non-

operational) from 2016 to 2130. The time limits are based on the limits of the Orbital Debris 

Engineering Model (ORDEM) as implemented in DAS. The current small-object environment 

(objects with sizes <10 cm), which is required for assessment of Requirement 4.5-2, ends in the year 

2050. The large-object environment (sizes ≥10 cm), required for collision risk assessment during 

both operational and post-mission phases, is projected to 2130. As a result, DAS cannot fully 

assess Requirement 4.5-2 for payloads still operational after 2050. 

 

 

1.2 Software Changes 
 

DAS 3 builds on the code base of DAS 2. Minor revisions to DAS 3 provide bug-fixes, important 

clarifications, and updated documentation. Some features of DAS 2 have been removed from 

DAS 3 due to their limited application or impractically long runtime. See the “Release Notes” file in 

the DAS installed folder for a detailed list of changes. 

 

1.2.1 Changes from DAS 3.1 to DAS 3.2 

 

DAS 3.2 includes updates that address revisions in the NASA Standard 8719.14C. DAS 3.2 also 

includes the latest version of ORDEM (3.2). The runtimes have not changed since the previous 

release of DAS.  

 

DAS 3.2.7 includes a new, command-line script capability. This allows users to run several DAS 

routines using a Python script without the DAS graphical user interface (GUI). See Appendix D for 

a description of the provided Python functions. This version also removes the limit on component 

tree depth from the assessment of casualty risk from reentry debris. 



 

2 

 

 

Version 3.2.7 introduces a collision area enhancement when calculating the probability of collision 

with large objects (Requirement 4.5-1).  Previous versions based the assessment on the debris 

environment flux through the average cross-sectional area of the object being assessed.  The new 

method considers the size of colliding objects.  This yields a higher collision probability when 

compared with earlier versions of DAS.  The relative increase depends on the assessed object's size 

compared with the debris distribution encountered on its orbit, appearing larger for smaller assessed 

objects/spacecraft. 

 

1.2.2 Changes from DAS 3.0 to DAS 3.1 

 

DAS 3.1 included the latest version of ORDEM at the time (3.1). The runtimes are expected to be 

shorter than the previous ORDEM 3.0 model, and users should no longer experience any “Not 

Responding” conditions. The ORDEM model was extended to the year range 2016–2130 (with only 

the greater than 10 cm flux evaluated beyond 2050). 

 

The simplified meteoroid flux model included in DAS was removed as it was no longer sufficient to 

assess the probability of disabling damage due to the natural environment. When evaluating 

penetration probability due to meteoroid flux, users must use the NASA Meteoroid Engineering 

Model (MEM). Users are encouraged to contact the NASA Orbital Debris Program Office. 

 

1.2.3 Changes from DAS 2.1 to DAS 3.0 

 

DAS 3.0 included updates that address revisions in the NASA Standard 8719.14B, as well as 

several usability improvements. Assessment of intentional breakups and tether systems were 

removed. In practice, those items are so unique that the general-purpose tool was of little use. The 

reentry survivability module now allows up to 1500 items. Reflecting recent research, the carbon-

fiber material types now have increased reentry survivability. Science and Engineering Tools that 

required days or weeks of computation due to ORDEM runtimes were removed. 

 

As with DAS 2.1, version 3.0 incorporated ORDEM 3.0, which is also developed by the NASA 

Orbital Debris Program Office. - 

 

1.3 Software Installation and Removal 
 

Recommended system for DAS 3.2: 

 

Windows 10/11 

Microsoft Visual C++ Redistributable runtime libraries 

Python interpreter version 3.7+ (for optional Python scripting interface) 

1GHz+ Intel (or compatible) CPU 

256MB+ RAM 

5.5GB+ available disk space 
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Software Installation: 

 

DAS is distributed as an executable setup file. The setup will install the program’s executable file 

and all necessary support files within the appropriate directories. The install program will analyze 

the computer’s existing operating system to identify required support elements for installation. The 

installation program will prompt for the following information: 

1. The Welcome window verifies that the installation of DAS is desired at this time. If not, 

select cancel.  

2. The Software License Agreement verifies that the user agrees to accept the software’s 

license. Disagreement will halt the installation. Agreement will proceed to the next step. 

3. Choose Install Location defines the default location where the application will be installed. 

A “Browse” button enables the user to view the file structure to define an alternative 

location. DAS must be installed in a location where the user has both read and write 

permissions. 

4. Choose Start Menu Folder defines a folder within the Windows Start→Programs list 

where the application shortcuts will be stored. The default setup will be provided but another 

name can be defined, or an existing program folder can be selected where this application 

will be loaded. 

5. Installing shows the progress as the software and data files are uncompressed and installed. 

6. Installation Complete notifies the user that the setup has completed. The computer will not 

require rebooting. 

7. The Completing window gives the user options to create a Windows Desktop shortcut for 

DAS and to display the Release Notes for this version. 

 

 

Do not remove or rename files and directories installed with DAS. Do not modify files within 

the DAS data directory (“[DAS]\data\”). Files and directories may be copied to another location 

if necessary, but DAS requires the files as originally installed. The one exception is the solar flux 

input table (file “[DAS]\data\solarflux_table.txt”), which the user must update when new versions 

are released. It should be replaced when a new version is posted on the NASA Orbital Debris 

Program Office website. 

 

Because DAS stores some session information in the Windows Registry, the software may not 

behave as expected if the user installs multiple versions on the same computer. It is recommended 

that previous versions of DAS be removed as part of the installation process. 

 

 

Software Removal: 

 

DAS includes an automatic removal (“un-installer”) feature (DAS3.2-uninstall.exe), which is found 

in the installed directory. There is also a shortcut to the un-installer in the Windows Start Menu 

folder created during DAS installation. To remove DAS, activate the automatic un-installer either 

through the Start Menu shortcut or directly. 
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Alternatively, the user may use the Windows “Add or Remove Programs” feature to remove DAS. 

Use the Windows Taskbar search feature or the Windows Start Menu, select Settings → Apps. In 

Apps & Features, highlight the entry for DAS and select Uninstall. You still may need to manually 

delete some files or folders from the directory where DAS was installed. 
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 2. DAS Main Window Features 
 

The DAS main window contains the top-level menus, toolbars, and a working area for the various 

DAS dialog windows. 

 

 

Figure 2-1: DAS Main Window 

 

 

2.1 Viewing Toolbars 
 

DAS provides two forms of toolbars to add convenience for application functions. The toolbars 

toggle on and off by selecting items from the View menu.  
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Run Toolbar contains buttons for easy navigation between the major dialogs:  
 

 

Mission Editor  

 

Requirement Assessments  

 

Science and Engineering 

 

Toolbar contains buttons for the following commands: 

 

 The disk button on the Toolbar saves the project to file (File→Save Project). 

 

 The print button prints the Activity Log. The print button (File→Print) is only available 

when viewing the Activity Log. 

 

 Context-sensitive help is available by clicking this button, then clicking on the item in 

question. The cursor changes to this icon when context-sensitive help is engaged.  

 

 The database button launches the Material Database Editor (Edit→Material Database).  

 

 The plot button launches the Plot Utility (View→View Plots). 

 

 The log button launches the Activity Log (View→Activity Log→View). 

 

 The calendar button launches the Date Conversion Utility (View→Date Converter). 
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2.2 Using the Mission Editor 
 
The Mission Editor is the starting point for assessing a mission’s compliance with NASA Technical 

Standard 8719.14C, Process for Limiting Orbital Debris. The Mission Editor dialog (Fig. 2-2) 

allows users to define spacecraft, rocket bodies, and mission-related debris for requirement 

assessment. Launch year, mission duration, orbital characteristics, and many other items are 

specified within this window, thus eliminating the need for re-declaring them in each of the 

following requirement assessment windows. 

 

 

 

Figure 2-2: DAS Mission Editor Dialog 

 

The Mission Editor window has three main editing areas: two edit fields at the top of the window 

(Mission Name and Start Date), the Mission Components view, and the editable Define 

Components Properties table at the bottom of the window. These areas are defined below along 

with information regarding the two buttons, Apply Changes and Reject Changes. 
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Mission Editor Fields: 

• Mission Name – This is a text field that holds the name of the mission that is being 

assessed. 

• Start Date – This field specifies the date the mission is planned to start. The date can be 

specified in decimal format. All years in orbit should fall between the years 2016 and 2130. 

This limit is enforced to ensure that the calculation models can provide accurate estimates. 

• Mission Components – A tree structure provides a quick look at all defined components of 

the mission. It is broken into three categories: payloads, rocket bodies, and mission-related 

debris. Each of these categories has different specifications for its components. When 

selecting an item, the grid area below the tree structure will change to reflect the properties 

of that type of component. Also, the individual item in the tree will be highlighted within the 

grid for quick reference or editing. 

• Define Component Properties Grid – This area is for defining and editing all the 

properties of each of the three categories of components. As mentioned above, there are 

three categories of components (payloads, rocket bodies, and mission-related debris). Each 

has its own set of properties, so selection of one type will only show components of that 

type. At the bottom of this grid is an empty row that can be used for adding new 

components. There is also a right mouse button menu available (click with the right mouse 

button on the table) for adding, deleting, or ordering of components.  

 

Upon completion of editing component data, the user should press the “Apply Changes” 

button. This will validate all the changes and save the data for later use in the requirement 

assessments. If the user wishes to abort changes since their last “Apply Changes” action, 

pressing the “Reject Changes” button will discard the changes. Each of these three category 

tables has different property fields and their descriptions and constraints are listed below. 

 

 

Important Note: In DAS, highlighting a text field is DIFFERENT from selecting the field. When a 

text field is highlighted, it is ready for input from the keyboard. The “highlight” may be moved 

using the arrow keys or a single mouse-click. A highlighted field is not, however, ready for cut-and-

paste operations. To select a field for cut, copy, or paste, the user must first highlight the field 

(using arrow keys or mouse), then click the mouse in the already-highlighted field. This will place a 

standard text cursor in the field. The user may then select the text within the field and use the 

standard cut/copy/paste operations.
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Payloads: 

Table 2-1: Mission Editor, Payload Grid 

Payload Name Payload Name is the unique identifier for each payload, and it must 

be distinct from all other component names. 

Mission Duration 

(yr) 

Mission Duration specifies the mission or operational lifetime of 

the payload beginning from the Launch Year. It is a decimal field 

(allowing partial years to be specified). This numeric value must be 

greater than zero.  

Operational 

Perigee Alt (km) 

Operational Perigee Altitude is measured from Earth’s surface to 

the spacecraft’s normal, operational orbit perigee point. This 

decimal value must be greater than 90 and less than or equal to 

100,000 kilometers. Operational Perigee Altitude must be less than 

or equal to Operational Apogee Altitude. 

Operational 

Apogee Alt (km) 

Operational Apogee Altitude is the distance measured from Earth’s 

surface to the spacecraft’s normal, operational orbit apogee point. 

This decimal value must be greater than 90 and less than or equal to 

100,000 kilometers. Operational Apogee Altitude must be greater 

than or equal to Operational Perigee Altitude. 

Operational 

Inclination (deg) 

Operational Inclination is the angle measured from Earth’s 

equatorial plane to the payload’s operational orbital plane. This 

decimal value must be between 0 and 180 degrees. 

RAAN (deg) Right Ascension of Ascending Node (RAAN) is a decimal value 

between 0 and 360 degrees. RAAN is only needed if the apogee 

altitude is greater than 2000 km. The field will remain inactive until 

an apogee altitude greater than 2000 km is entered. 

Argument of 

Perigee (deg) 

Argument of Perigee is a decimal value between 0 and 360 degrees. 

This value is only needed if the apogee altitude is greater than 

2000 km. The field will remain inactive until an apogee altitude 

greater than 2000 km is entered. 

Mean Anomaly 

(deg) 

Mean Anomaly is a decimal value between 0 and 360 degrees. 

Mean Anomaly is only needed if the apogee altitude is greater than 

2000 km. The field will remain inactive until an apogee altitude 

greater than 2000 km is entered. 

PMD Maneuver 

(check if Yes) 

Postmission Disposal (PMD) Maneuver is a check box entry. 

Placing a check in the box indicates a planned disposal maneuver in 

space.  

A check in this field will enable the disposal orbital parameter 

fields of the grid. 

Disposal Perigee 

Alt (km) 

Perigee Altitude for postmission disposal orbit is a decimal value 

that must be greater than 90 and less than or equal to 

100,000 kilometers. Perigee altitude must be less than or equal to 

apogee altitude. 
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Disposal Apogee 

Alt (km) 

Apogee Altitude for postmission disposal orbit is a decimal value 

than must be greater than 90 and less than or equal to 

100,000 kilometers. Apogee altitude must be greater than or equal 

to perigee altitude. 
Table 2-1 - Continued 

Disposal 

Inclination (deg) 

Inclination for postmission disposal orbit is a decimal value that 

must be between 0 and 180 degrees. 

Disposal RAAN 

(deg) 

RAAN for postmission disposal orbit is a decimal value that must 

be between 0 and 360 degrees. RAAN is only needed if the disposal 

apogee altitude is greater than 2000 km. The field will remain 

inactive until a disposal apogee altitude greater than 2000 km is 

entered. 

Disposal Arg of 

Perigee (deg) 

Argument of Perigee for postmission disposal orbit is a decimal 

value that must be between 0 and 360 degrees. Argument of Perigee 

is only needed if the disposal apogee altitude is greater than 

2000 km. The field will remain inactive until a disposal apogee 

altitude greater than 2000 km is entered. 

Disposal Mean 

Anomaly (deg) 

Mean Anomaly value for postmission disposal orbit is a decimal 

value that must be between 0 and 360 degrees. Mean Anomaly is 

only needed if the disposal apogee altitude is greater than 2000 km. 

The field will remain inactive until a disposal apogee altitude 

greater than 2000 km is entered. 

Initial Mass (kg) Initial Mass is a decimal field for the mass of the payload (in 

kilograms) at the start of the mission in the operational orbit, 

including all fluids and all internal fragments (aero mass). 

Final Mass (kg) Final Mass is a decimal field representing the mass of the payload 

(in kilograms) after the payload’s mission and all postmission 

passivation actions are completed. This should be the dry aero mass 

of the payload if all fluids have been expended. 

Final Area-To-

Mass (m 2 /kg) 

Final Area-To-Mass is a decimal field representing the frontal 

cross-sectional area of a payload (in square meters) divided by the 

final mass of the payload (in kilograms). Calculation of the frontal 

area depends on orientation of the payload; uncontrolled orientation 

uses the average cross-sectional area. 

Station Keeping 

(check if Yes) 

Station Keeping is a check box field. If checked, the payload’s 

orbital elements are fixed throughout its mission duration. During 

its mission duration, the payload is precluded from natural orbital 

decay by active station keeping devices, e.g., thrusters. DAS 3 

assumes that if an object is “Station Kept,” the user input orbital 

elements will not be subject to decay. Objects that are not Station 

Kept will be assumed to decay naturally throughout their lifetime. 

Long-Term 

Reentry (check if 

Yes) 

Long-Term Reentry is a check box field. If checked, the payload’s 

postmission disposal will be automatically assessed against 

Requirement 4.6-3, long-term reentry using orbital resonances, 

only. 
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Rocket Bodies: 

Table 2-2: Mission Editor, Rocket Body Grid 

Rocket Body Name Rocket Body Name is the unique identifier for each rocket body 

and it must be distinct from all other component names. 

Perigee Alt (km) Perigee Altitude is measured from Earth’s surface to the rocket 

body’s disposal orbit apogee point. This decimal value must be 

greater than 200 and less than or equal to 100,000 kilometers. 

Perigee altitude must be less than or equal to apogee altitude. 

Apogee Alt (km) Apogee Altitude is measured from Earth’s surface to the rocket 

body’s disposal orbit perigee point. This decimal value must be 

greater than 200 and less than or equal to 100,000 kilometers. 

Apogee altitude must be greater than or equal to perigee altitude. 

Inclination (deg) Inclination of the disposal orbit with respect to Earth’s equatorial 

plane. This decimal value must be between 0 and 180 degrees. 

RAAN (deg) RAAN is a decimal between 0 and 360 degrees. RAAN is only 

needed if the apogee altitude is greater than 2000 km. The field 

will remain inactive until an apogee altitude greater than 2000 km 

is entered. 

Argument of 

Perigee (deg) 

Argument of Perigee value is a decimal value between 0 and 

360 degrees. This value is only needed if the apogee altitude is 

greater than 2000 km. The field will remain inactive until an 

apogee altitude greater than 2000 km is entered. 

Mean Anomaly 

(deg) 

Mean Anomaly is a decimal value between 0 and 360 degrees. 

This value is only needed if the apogee altitude is greater than 

2000 km. The field will remain inactive until an apogee altitude 

greater than 2000 km is entered. 

Final Mass (kg) Final Mass is a decimal value representing the mass of the rocket 

body (in kilograms) after the rocket body’s mission is complete 

and after passivation. 

Final Area-To-

Mass (m 2 /kg) 

Final Area-To-Mass is a decimal value representing the average 

cross-sectional area of the rocket body (in square meters) divided 

by the final mass of the rocket body (in kilograms).  

Long-Term Reentry 

(check if Yes) 

Long-Term Reentry is a check box field. If checked, the rocket 

body’s postmission disposal will be automatically assessed 

against Requirement 4.6-3, long-term reentry using orbital 

resonances, only. 
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Mission-Related Debris: 

 

Mission-Related Debris items only need to be defined if they pass through low Earth orbit (LEO) 

and are 1 mm or larger in size or if they pass through geosynchronous orbit (GEO) and are 5 mm or 

larger in size.  

Table 2-3: Mission Editor, Mission-Related Debris Grid 

Debris Name Debris Name is the unique identifier for this component and its 

value must be distinct from all other component names. 

Released Year Released Year is a decimal value that defines the date that this 

debris is released from the spacecraft or rocket body. This value 

must be equal to or greater than the mission’s launch year. 

Quantity of Each 

Element 

Quantity of Each Element is the number of debris items of this 

type that will be released. It must have a value of one or greater.  

Area-To-Mass 

(m 2 /kg) 

Area-To-Mass is a decimal value for the average cross-sectional 

area of the debris (in square meters) divided by the mass of the 

debris (in kilograms).  

Perigee Alt (km) Perigee Altitude is measured from Earth’s surface to the debris 

object’s perigee point. This decimal value must be greater than 90 

and less than or equal to 100,000 kilometers. Perigee altitude 

must be less than or equal to the apogee altitude. 

Apogee Alt (km) Apogee Altitude is measured from Earth’s surface to the debris 

object’s apogee point. This decimal value must be greater than 

90 km and not exceeding 100,000 km. Apogee altitude must be 

greater than or equal to the perigee altitude. 

Inclination (deg) Inclination of the debris object’s orbit; a decimal value between 

0 and 180 degrees. 

RAAN RAAN is a decimal value between 0 and 360 degrees. This value 

is only needed if the apogee altitude is greater than 2000 km. The 

field will remain inactive until an apogee altitude greater than 

2000 km is entered. 

Argument of 

Perigee (deg) 

Argument of Perigee is a decimal value between 0 and 

360 degrees. This value is only needed if the apogee altitude is 

greater than 2000 km. The field will remain inactive until an 

apogee altitude greater than 2000 km is entered. 

Mean Anomaly 

(deg) 

Mean Anomaly is a decimal value between 0 and 360 degrees. 

This value is only needed if the apogee altitude is greater than 

2000 km. The field will remain inactive until an apogee altitude 

greater than 2000 km is entered. 
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2.3 Requirement Assessments 
 

The Requirement Assessments window provides an adjustable split window to view the dialogs 

for each requirement supported by DAS. The dialog contains a list of supported requirements in the 

left windowpane. As a requirement is selected, the supporting dialog will appear in the right pane. 

Data entered into the Mission Editor serve as input data for the requirements, though additional 

input may be required. As data are analyzed in each requirement, the compliance state is displayed 

as an icon next to that label in the left window. Additional information appears in the output area at 

the bottom of each requirement assessment window. If the mission is compliant with a requirement, 

a green check icon will appear next to the requirement name. If the mission is not compliant, a red 

“X” will appear. The user may use the mouse to adjust the position of the divider between the left 

and right windows. 

 

As data are input, requirements are assessed, and output is generated, the data will be retained 

within the project’s data. It is saved to the project files when the user agrees to saving the data on 

application termination or selects the File→Save Project command from the main menu. 

 

Selecting various requirements only affects the current view in the right side of the window. The 

information and state are retained if the requirement assessment window is open. Assessment status 

is lost when the window is closed. 

 

Changes within the Mission Editor can affect data used within the previously opened requirements. 

When changes to mission data are applied within the Mission Editor, the Requirement 

Assessments window is closed, and all compliance states are reset. 

 

All assessments can be reset to initial state (not run) by depressing the “Reset” button in the right 

windowpane displayed with the upper requirement level (NS 8719.14 - Process for Limiting Orbital 

Debris). 

 

Chapter 3 provides details of each assessment’s operations.  
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Figure 2-3: Requirement Assessments Top-level Dialog 

 

 

2.4 Science and Engineering Utilities 
 

The Science and Engineering utilities allow the user to analyze some aspects of orbit/mission design 

outside the context of Requirement Assessments. 

 

To access each tool, expand a category from the tree and then double-click the mouse over the selected 

routine. The corresponding dialog will appear. 

 

Chapter 4 provides details of the Science and Engineering Utilities. 
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2.5 Using the Material Database Editor 
 

Reentry assessment requires information on the type of material used in an object’s construction. The 

Material Database provides a view of standard materials used by the underlying application and a means 

to define additional materials specific to a mission. See Appendix C for a table of properties of the 

standard materials. 

 

The Material Database dialog can be opened to view the defined data or add user-defined materials by 

pressing the database button  on the Toolbar or selecting Edit→Material Database from the 

application menu. 

 

If an object uses a material that is not on the standard list, user-defined materials may be created 

specifically for the current project, defining:  

• Unique material name 

• Density 

• Specific heat 

• Heat of fusion  

• Melt temperature 

• Emissivity (default “1”) 

• Specific Heat (Slope) (default “0”) 

• Emissivity (Slope) (default “0”) 

 

Note that material density is only used as a “sanity check” (i.e., limiting case) on user inputs of mass and 

size. It is used to verify that the data input for an object’s mass and dimensions are consistent.  

 

Newly defined materials are saved to the project\matprop.csv file by pressing the “Save” button. 

 

Closing the dialog without saving updates will prompt the user to save. 

 

 

2.6 Using the Plot Viewer 
 

DAS includes a two-dimensional plot viewing utility for displaying previously saved DAS .dpl files. To 

activate the plot utility, press the plot viewer button  on the Toolbar, or select View→View Plots 

from the application menu. The DAS Plot window will open containing a blank two-dimensional plot 

layout. The plot window will also be generated by functions in the Science and Engineering utilities.  

 

The plot utility provides the following buttons to manage plot files: 

• Load Plot – Displays an Open Plot File dialog to navigate to a previously saved *.dpl file to be 

loaded into the display area of the Plot Utility. 
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• Save Plot – Provides a Save Plot dialog to specify the name and directory location for the saved 

*.dpl file. The dialog defaults to the “My Documents” directory. 

• Copy to Clipboard – Copies the plot image to the Windows clipboard. An acknowledgement 

dialog will appear, requiring an “OK” to proceed. The image may then be pasted into other 

(non-DAS) applications. 

• Close – Closes the Plot Utility. Be certain that all desired changes have been saved before 

closing the window since no save prompt will remind the user before closing the window. 

 

A single right-click or double left-click of the mouse on the plot area (left windowpane) will display a 

pop-up menu with additional plotting functionality: 

• Select – Allows users to select objects with the mouse. Select returns the cursor state to a 

pointed arrow and turns off other cursor functions (Zoom, Pan, Cursor). 

• Zoom – Allows users to isolate and enlarge a rectangular area of the plot. The cursor changes to 

a crosshair ( ). By holding the left-mouse button while dragging the crosshair over the plot, a 

rectangular highlight area appears. Size the rectangle by maneuvering the mouse over the plot. 

Releasing the mouse button enlarges the highlighted rectangular area. The axes adjust to the 

zoomed size.  

• Reset – Allows users to reset all axes to optimal values. 

• Pan – Allows users to move the plotted curve(s) within the plot area. The cursor changes to the 

pan cursor ( ). The cursor can be moved by holding the left-mouse button while dragging the 

cursor over the plot. The axes scale to fit the pan. To stop the action, release the mouse. To leave 

Pan mode, right-click on the plot and choose “Select” from the pop-up menu. 

• Cursor – Provides the means to capture the mouse’s position on the plot, interpolating the 

mouse coordinates to the corresponding plot scale. The cursor changes to a crosshair ( ), and 

one vertical and one horizontal line intersect marking the cursor’s position. Clicking the 

left-mouse button inserts a label onto the graph with the interpolated values. Clicking the 

right-mouse button launches the pop-up menu. Choose “Select” from the pop-up menu to 

change the cursor back to a pointing arrow. To remove the labels from the graph, return to Select 

mode, click the left-mouse button over the desired label object, noting that the item has been 

activated, and then depress the “Delete” key on the keyboard. 

• Insert Label – Inserts a blank label (text box) onto the plot. Click the left-mouse button on the 

label until the object is activated and then double-click the left mouse button within the label. 

This action should change the cursor to a vertical text cursor within the label. Once the cursor 

changes, begin typing or paste any previously copied text. The label can be moved and sized by 

manipulating the mouse after activating the label. When the object is activated, additional 

functionality becomes available. Clicking the right-mouse button within the activated label 

launches a label properties dialog box: 

o Background color – Launches a color palette for selecting and changing background 

color. 

o Font – Launches a common font dialog. 

o Alignment – Provides a means to align the text left, centered, or right. 
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o Connect to curve – Combo box allows users to choose to which curve the label will be 

attached. 

o Transparent and Border check boxes – Provide optional label bordering.  

Labels in the plot area may be selected with a single left-mouse click. Once selected, a label may 

be moved, resized, activated (for editing), or deleted. This applies to both user-inserted labels 

and to automatic labels (such as the plot title). 

• Print – Provides a means to print an active plot to a designated printer by selecting printer 

characteristics and functions from a print dialog window. Currently, only grayscale printing is 

available; however, plots copied to another application (e.g., word processor) can be printed 

based on that application’s print support. 

• Properties – Opens a dialog to set various properties for the displayed plot. Once properties are 

changed, click “Apply” (immediately apply changes and leave dialog open) or “OK” (apply 

changes and close dialog) to activate the changed properties. “Cancel” will close the dialog 

without applying any selected changes. The three tabbed sets of property categories are:  

o Chart – Has nine controls that offer additional features for changing the way the plot is 

displayed. 

▪ Background color – Dialog that allows users to set the color outside the plot area 

and labels. 

▪ Exterior color – Dialog that allows users to set the color behind the axes and the 

color of the grid lines on their plot. 

▪ Interior color – Dialog that allows users to set the color of the plot inside the axes. 

▪ Show Legend – Position the legend to either the left or right of the plot or remove it. 

▪ Snap Cursor to nearest curve – Position the cursor to the curve within a specified 

tolerance (up to 100 pixels). 

▪ Select x-axis – Applies the x-axis properties on the Axis property dialog. Leaving 

the field blank selects the y-axis. 

▪ Select y-axis – Applies the y-axis properties on the Axis property dialog. Leaving 

the field blank selects the x-axis. 

▪ Select curve – Selects a specific curve’s properties on the Curve property dialog. 

▪ Double Buffering – Turns double buffering either on or off. Double buffering can 

improve the appearance of moving images (pan and zoom). 

o Axis – properties allow users to modify various axis features such as scale, tick-size, 

font, and grid color. Select an axis in the Chart tab before modifying properties in the 

Axis tab. Once choices have been completed for each axis, depress “Apply” or “OK” to 

process the changes. 

o Curve – properties allow users to modify various curve features such as line width, line 

color, curve trends, and marker size. Select a curve in the Chart tab before modifying 

properties in the Curve tab. For each curve, depress “Apply” or “OK” to process the 

selected changes.  
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2.7 Using the Date Conversion Utility 
 

The Date Conversion utility is provided for easy conversion between the following date formats: 

• Calendar Format – The year, month, and day can be selected in the calendar control. The user 

may select another month by pressing the previous (left) or next (right) arrow buttons within the 

calendar title, or by clicking on the name of the month. To select another year, click on the year 

within the title and then roll forward (up) or back (down) using the control that will appear next 

to the year. The day selected within the lower calendar will remain selected for the changed year 

or month. 

• Decimal Date – The format for decimal date is:  yyyy.ddd, where ddd is the decimal portion of 

the year. For example: June 30, 2006, is formatted as “2006. 496,” and November 15, 2005, is 

formatted as “2005.874.” 

• Day of Year – The format for day of year is yyyy doy, where doy is the numeric day within the 

year’s days (365, 366). For example: June 30, 2006, is formatted as “2006 181,” and 

November 15, 2005, is formatted as “2005 319.” 

 

Activate the Date Conversion Utility by pressing the calendar button  on the Toolbar or by selecting 

View→Date Converter from the application menu. As a date is entered within any control, that date 

will be displayed in the other controls in the control’s supported format. 

 

 

2.8 Viewing the Activity Log 
 

The Activity Log provides a means to view all data processed within the DAS application. As 

requirements are assessed, the data input and the resulting output are written to the Activity Log. The 

data are written to the text file ActivityLog in the current project’s directory. The file can be used to track 

a problem with data or to capture text based on the project being defined. To view the activity log, press 

the logbook button  on the Toolbar, or select View→Activity Log→View from the application menu. 

 

As the program starts, the previous ActivityLog file is overwritten. To save a copy of the current 

ActivityLog file to an alternate location, select File→Save Log As… from the application menu. The 

file can be viewed outside DAS in a text editor/viewer (e.g., WordPad or Word) and printed using the 

DAS menu items File→Print Setup, File→Print Preview, and File→Print. 

 

The Activity Log can be cleared during processing by selecting View→Activity Log→Clear from the 

application menu. This function can be used to reduce the amount of data viewed during processing 

without changing the underlying text saved in the log file. 

 

Previously cleared views of the Activity Log can be restored (to view all data processed since the 

program started) by selecting the View→Activity Log→Restore menu item.  

 

The clear and restore functions do not affect the underlying ActivityLog file. 
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2.9 Saving and Loading Projects 
 

In DAS, all data are stored as a “project.” A project consists of a directory with many files that retain all 

the data that the user may define within the application. The default project is an example directory 

folder named “project/” within the installed DAS directory.  

 

Use the File→New Project menu function to create a new project. The Define New Project Path 

dialog will appear for entering the path. A browse button (…) next to the path entry opens the Browse 

for New Project Folder dialog to view the computer’s paths and select existing directories with defined 

mapped paths. The dialog contains an edit control to enter the name of the new directory if it does not 

already exist. When the OK button in either dialog is pressed, the directory will be created. If the project 

directory already exists, DAS will prompt the user with a reminder that any previously saved data in that 

directory will be replaced by the new project. The new project is opened in its initial (blank) state. This 

action will then launch the Mission Editor so that a new mission may be defined.  

 

To create a new project based on a currently open project, select the File→Save Project As… menu 

item. Its function is like the New Project function except that any existing data is saved in the new 

directory, including any updates applied since the project was opened or previously saved. If the project 

directory already exists, DAS will prompt the user with a reminder that any previously saved data in that 

directory will be replaced by the new project.  

 

To open a project, select the menu item File→Open Project. The Open Project dialog is like the 

Define New Project Path dialog except that the browse dialog does not support the creation of new 

directories and the Open Project dialog will verify that the selected directory contains the required 

das.prj file. An invalid (incomplete) project directory will not open and the dialog will remain open.  

Note that, starting with version 3.2.4, DAS performs a one-way conversion of pre-3.2 project data files 

to the current formats. Users who need to retain their old DAS project files should make backup copies. 

 

As projects are opened, the path is saved and will appear on the File menu above the Exit item. Up to 

four projects are collected as recently used projects and will appear in the order referenced, with the 

latest at the top. When the application opens, if the most recent project path is still valid, that project will 

open instead of the initial default path. 

 

The application does not retain updates to the project unless the user selects the File→Save Project 

menu item, presses the project save button  on the toolbar, or closes the application and chooses 

“Yes” on the prompt to save their data. This allows the user the option to close without saving and 

return to the last saved state. 
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 3. Assessing Compliance with the NASA Debris Requirements 
 

The Requirement dialog contains a list of supported requirements in the left window (some 

requirements must be assessed outside of DAS). As a requirement is selected, the supporting dialog 

will appear in the right window. All data input into the requirement window will be retained until 

the application closes. The result of the requirement assessment will appear as an icon next to that 

label in the Requirements window. 

 

As requirements are processed and output is generated, the information will be retained within the 

project data. It will be saved to the project files when the user agrees to saving the data on 

application termination. 

 

Selecting various requirements only affects the current view in the right side of the window. The 

data and state are retained as long as the requirement assessments window is open. Compliance 

state is lost when the window is closed. 

 

Changes within the Mission Editor can affect data used within the previously opened requirements. 

When changes to data are applied within the Mission Editor, the Requirement Assessments 

window is closed, and all states are reset. 

 

Note: The information in this section pertains to the DAS assessment of elements from NASA’s 

Process for Limiting Orbital Debris. Because these instructions contain excerpts and paraphrasing 

from the NASA Technical Standard, the reader should consult the Standard itself for the official 

text of the requirements. The text of the requirements is provided in Appendix B of this User’s 

Guide. 

 

 

3.1 Requirement 4.3-1: Debris Passing Through LEO 
 

For missions leaving debris in orbits passing through LEO, released debris with diameters of 1 mm 

or larger must satisfy both of the following conditions: 

 

a. All debris released during the deployment, operation, and disposal phases shall be limited 

to a maximum orbital lifetime of 25 years from date of release. 

 

b. The total object-time product shall be less than 100 object-years per launch vehicle upper 

stage or per spacecraft. 

 

The intent of Requirement 4.3-1 is to remove debris in LEO from the environment in a reasonable 

period of time. The 25-year removal time from LEO limits the growth of the debris environment 

over the next 100 years while limiting the cost burden to programs and projects. 

 

Debris in orbits with perigee altitudes below 600 km will usually have orbital lifetimes of less than 

25 years. This requirement will have the greatest effect on programs and projects with perigee 

altitudes above 700 km, where objects may remain in orbit naturally for hundreds of years. 

 



 

21 

 

Requirement 4.3-1 applies to staging components, separation and deployment hardware, and other 

objects that are known to be released during normal operations and end-of-mission (EOM) 

passivation/disposal. Spacecraft and spent orbital stages are addressed in other Requirements, with 

the exception that satellites smaller than a 1U standard CubeSat must follow this 100 object-years 

per mission deployment limit in addition to other applicable requirements. This DAS module can 

help the user assess such small satellites with respect to Requirement 4.8-1b. 

 

 

 

Figure 3-1: Requirement 4.3-1 Debris Passing Through LEO Dialog 

 

 

Input Data: 

 

The data displayed in the input grid are “read-only.” To modify the input data, the user must return 

to the Define Mission-Related Debris Properties grid of the Mission Editor. 

 

Output Data: 

 

Each debris object is assigned a compliance status. If any object is not in compliance, then the 

mission does not comply with Requirement 4.3-1.  
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The total object-time product (applies to Requirement 4.3-1b) is the sum, over all objects, of the 

orbital dwell time in LEO. If the debris is in an orbit with apogee altitude below 2000 km, the orbit 

dwell time equals the orbital lifetime. The total object-time product should be no larger than 

100 object-years per rocket body or per spacecraft.  

 

For example, if the LEO dwell time for a debris object is calculated to be 25 years, then no more 

than four such objects can be released for the mission to be compliant with the 100 object-years 

limit of Requirement 4.3-1b. Requirement 4.3-1a limits the total orbital lifetime of each single piece 

of debris passing through LEO to 25 years, regardless of how much time per orbit is spent below 

2000 km. If the LEO dwell time of the debris is only 20 years, then a total of up to five debris 

objects can be released and still satisfy Requirement 4.3-1b, as long as the maximum orbital lifetime 

of each object does not exceed 25 years. 

 

Messages and comments developed during analysis are displayed on the dialog, below the output 

data. 

 
 

3.2 Requirement 4.3-2: Debris Passing Near GEO 
 

For missions leaving debris in orbits with the potential of traversing GEO (GEO altitude ± 200 km 

and ≤ 15 inclination), released debris with diameters of 5 mm or greater shall be left in orbits 

which will ensure that within 25 years after release the apogee will no longer exceed GEO - 200 km 

or the perigee will not be lower than GEO + 200 km, and also ensures that the debris is incapable of 

being perturbed to lie within that GEO ± 200 km and ± 15 zone for at least 100 years thereafter. 

 

Debris that are not removed from GEO altitude may remain in the GEO environment for many 

thousands of years or longer. Therefore, Requirement 4.3-2 limits the accumulation of debris at 

GEO altitudes and will help mitigate the development of a significant debris environment, as 

currently exists in LEO. To ensure that the mission is compliant with Requirement 4.3-2, the 

spacecraft must be sufficiently above or below GEO at the time of debris release. The 200 km offset 

distance takes into account the operational requirements of GEO spacecraft. 

 

Requirement 4.3-2 includes debris released by a spacecraft, such as solid rocket motor casings and 

other objects that are known to be released during normal operations. 

 

Mission-related debris passing near GEO, in general, can be categorized as in “nearly circular” or in 

“highly eccentric” orbits. An example of a nearly circular orbit would be debris, e.g., a solid rocket 

motor casing, released by a spacecraft after the spacecraft has already been inserted into an orbit 

near GEO. 

 

Debris might also originate from a launch vehicle orbital stage that has inserted its payload directly 

into an orbit near GEO. In such a case, all debris should be eliminated entirely, or the orbital stage 

should be sufficiently removed from the GEO regime at the time of debris release. 
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Debris may in limited cases also be released into highly eccentric geosynchronous transfer orbits 

(GTO) with perigee altitudes near LEO or at higher altitudes and with apogee altitudes near GEO 

but must be consistent with Requirement 4.6-2. (For debris passing through LEO, Requirements 

4.3-1a and 4.3-1b take precedence.) Debris released at the time of payload separation on a mission 

of this type would fall under Requirement 4.3-2. 

 

Debris can be left in an eccentric orbit traversing GEO if orbital perturbations will cause the object 

to leave the GEO regime within 25 years. The orbit propagator within DAS can be used to 

determine the long-term orbital perturbation effects for specific initial orbital conditions and hence, 

to determine compliance with Requirement 4.3-2 by ensuring the debris will not reenter the GEO 

protection zone within 100 years. 

 

Special orbit propagation models are necessary to evaluate the evolution of disposal orbits to ensure 

that debris do not later interfere with GEO as a result of major perturbations such as solar and lunar 

gravitational perturbations and solar radiation pressure. 

 

 

Figure 3-2: Requirement 4.3-2 Debris Passing Near GEO Dialog 
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Input Data: 

 

The data displayed in the input grid is “read-only.” Input to the requirement is entered through the 

Mission Editor under the Define Mission-Related Debris Properties grid. 

 

Output Data: 

 

Once processed, output is displayed in the output area of the dialog. Each debris object is assigned a 

compliance status. If any object is not in compliance, then the mission does not comply with 

Requirement 4.3-2. 

 

Messages and comments developed during analysis are displayed on the dialog, below the output 

data.  

 

 

3.3 Requirements 4.4-1, 4.4-2, 4.4-3, and 4.4-4: Not Covered by DAS 
 

The current version of DAS will not determine compliance with Requirements 4.4-1, 4.4-2, 4.4-3, 

or 4.4-4. The project must demonstrate compliance with Requirements 4.4-1 and 4.4-2 through its 

own calculations. For Requirements 4.4-3 and 4.4-4, contact the NASA Orbital Debris Program 

Office for assistance. 

 

 

3.4 Requirement 4.5-1: Debris Generated by Collisions with Large Objects 
 

Catastrophic collisions during orbital lifetime represent a direct source of debris, and the probability 

of this occurring is addressed by Requirement 4.5-1. This Requirement limits the amount of debris 

that will be created by collisions between spacecraft or launch vehicle stages passing through 

heavily populated orbit bands (LEO and GEO) and other large objects in orbit. By limiting the 

uniform probability of collision with other large objects to less than 0.001, NASA attempts to 

achieve its goal that the average probability will be less than 10-6 of any individual operating 

spacecraft colliding with a fragment >1 mm from a prior collision. 
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Figure 3-3: Requirement 4.5-1 Limiting Debris Generated by Collisions with Large Objects Dialog 

 

Input Data: 

 

Payloads and rocket bodies defined for the mission are included as input for this assessment. The 

data displayed in the input grid are “read-only.” To modify the input data, the user must return to 

the Define Mission-Related Debris Properties grid of the Mission Editor. 

 

Output Data: 

 

The output area of the dialog displays results listed by component. The output table displays 

compliance status of each component and the computed probability of collision with a large object. 

The probability of accidental collision with space objects larger than 10 cm in diameter must be less 

than 0.001. 

 

Messages and comments developed during analysis are displayed on the dialog, below the output 

data. Software runtimes depend mainly on the size of the time and altitude ranges; a long-duration, 

highly eccentric orbit may result in a DAS runtime measured in days. 

 

If the user selects the long-term reentry option (see Section 3.6) then the probability of collision 

with large objects reported here is only for the operational phase (i.e., mission duration).  
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3.5 Requirement 4.5-2: Probability of Damage from Small Debris 
 

Requirement 4.5-2 limits the probability that a spacecraft will become disabled and unable to 

perform end-of-mission tasks, such as disposal maneuvers and passivation. This could contribute to 

the long-term growth of the orbital debris environment by subsequent collision or explosion 

fragmentation. For each spacecraft, the program or project shall demonstrate that, during the 

mission of the spacecraft, the probability of accidental collision with orbital debris and meteoroids 

sufficient to prevent compliance with the applicable postmission disposal maneuver requirements is 

less than 0.01. 

 

Due to the very short mission duration of launch vehicle orbital stages (normally less than 

24 hours), the probability of a disabling small debris impact on orbital stages is not significant.  

 

Requirement 4.5-2 applies only to subsystems that are vital to completing postmission disposal. 

This includes components needed for either controlled reentry or transfer to a disposal orbit. 

Examples of such subsystems are propellant lines and tanks, attitude control system, batteries and 

power lines, and communications equipment. The same methodology can be used to evaluate the 

vulnerability of the spacecraft instruments and mission-related hardware. This information can be 

used to verify the reliability of the mission with respect to orbital debris hazards. DAS does not 

impose a debris size limit but applies the penetration model to the full range of the ORDEM model. 

DAS does not assess hazards due to meteoroids. 

 

Payloads are defined in the Mission Editor and displayed in Requirement 4.5-2. 

 

The debris environment model in DAS has been simplified by excluding small debris in years 

2051–2130. Therefore, DAS cannot assess Requirement 4.5-2 for missions operating after 2050. 

See Appendix C.3 for more information. 
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Figure 3-4: Requirement 4.5-2 Probability of Damage from Small Debris Dialog 

 

Input Data: 

 

Payloads cannot be added to a mission through Requirement 4.5-2, only through the Mission Editor. 

Critical surfaces are created and defined for the payload by depressing the “Add” button. Once the 

surface has been created, fields to define the critical surface become available.  
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The user selects a Payload Orientation from the drop-down combo box. Orientation is defined as 

one of: 

• Random tumbling – No axes will be fixed during the mission lifetime in question. 

• Gravity gradient – The gravity (nadir) direction will be maintained with respect to the 

spacecraft during the orbital lifetime in question. 

• Fixed orientation – The velocity (ram) direction and gravity (nadir) direction will be 

maintained with respect to the spacecraft during the orbital lifetime in question. 

 

“Random tumbling” should be used to describe payloads that do not have attitude maintenance 

capability. For payloads that are “gravity gradient” or have “fixed orientation,” users must define 

unit vectors in spacecraft coordinates.  

 

A critical surface is the surface that, if damaged, may cause postmission disposal to fail. Each 

payload may have one or many critical surfaces. Examples of components with critical surfaces 

include fuel tanks, conduits, wires, and circuit boards. Each critical surface is defined by surface 

name; areal density (the product of material mass density and thickness); projected surface area; 

unit normal vectors U, V, W (if Payload Orientation is not random tumbling); and whether the back 

wall is the wall of a pressurized vessel (check the box if “Yes”). The unit normal vector need only 

be directional since DAS will normalize the vector internally. The coordinate system is defined as: 

• U – “Up” (the direction opposite to the direction of gravity)  

• V – In the direction of velocity  

• W – “Port” or orthogonal to both U and V (i.e., U×V) 

 

Note that a single hardware component may have more than one critical surface. The user cannot 

always tell whether a heavily or weakly armored surface is most vulnerable since this depends on 

the surface’s location on the vehicle. Therefore, assessment needs to account for all “critical 

surfaces” of each critical hardware component, including any surface that points in a different 

direction or has a different outer wall configuration. Random tumbling surfaces do not need to 

consider pointing but do need to consider wall configurations. 

 

If checked, the check box labeled “Pressurized” indicates that the back wall is the wall of a 

pressurized vessel. 

 

Each critical surface requires definition (physical characteristics) of the layers between that surface 

and the space environment. These bordering layers include any layers between the back wall and an 

external wall, inclusively. The physical characteristics of these layers are defined in the Outer 

Walls input grid. Defining characteristics are listed in Table 3-1. Figures 3-5 through 3-7 show a 

simple example of defining critical surfaces. Figure 3-5 shows the critical hardware (circle) within 

the payload, with critical surfaces identified in two directions. Figure 3-6 shows the decomposition 

of the payload into the critical surfaces and shielding layers. Figure 3-7 shows the arrangement and 

separation distances of the layers. Table 3-2 lists the example properties and resulting DAS inputs 

for the example Critical Surface 2. 
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Table 3-1: Requirement 4.5-2 Outer Walls Input Grid 

Name A descriptive name (text field) for the layer. 

Areal Density Areal Density (g/cm 2 ) of the layer. The density must be a 

positive numeric value greater than zero. Decimal values are 

valid. This value, the product of material mass density and 

thickness, accounts for material density and thickness. 

Separation Distance Distance (cm) between the critical surface (i.e., back wall) and 

this layer. The distance must be a positive numeric value greater 

than zero. Decimal values are valid. The layers do not need to 

be sorted by separation distance. 

 

 

 

 

 

Figure 3–5: Block Diagram of a “Critical Surface” within a Spacecraft 
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Figure 3–6: Conversion of Critical Surface Block Diagram to Layers 

 

 

 

 

Figure 3–7: Critical Surface and Shielding Layers Arrangement and Separation 
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Table 3–2: Properties Used to Evaluate the Example Critical Surface 2 

Layer Name Material Material 

Density 

(kg/m3) 

Layer 

Thickness 

(cm) 

Areal Density 

[Density x 

Thickness] 

(g/cm2) 

Separation 

Distance 

from Critical 

Surface (cm) 

Critical Surface 2 Al 2700 0.2 0.540 N/A 

Box 1 wall Al 2700 0.2 0.540 2.7 

Box 2 wall 1 Al 2700 0.2 0.540 4.7 

Circuit board 1 GFRP 1840 0.1 0.184 7.4 

Circuit board 2 GFRP 1840 0.1 0.184 11.8 

Box 2 wall 2 Al 2700 0.2 0.540 14.0 

Exterior wall, top, 

inner sheet 

Graphite 

Epoxy 

1550.5 0.1 0.155 15.5 

Exterior wall, top, 

outer sheet 

Graphite 

Epoxy 

1550.5 0.1 0.155 16.1 

 

 

Output Data: 

 

Compliance status for each spacecraft is displayed in the Output and Message area of the dialog, as 

is probability that small debris impacts will cause components critical to postmission disposal to 

fail. For each spacecraft, each user-defined critical surface is also listed, along with the probability 

that the critical surface will be penetrated by a small object.  

 

Messages and comments developed during analysis are displayed on the dialog, below the output 

data.  

 

The assessment of Requirement 4.5-2 should be used to determine whether damaging impacts by 

small particles can reasonably prevent successful postmission disposal operations. The procedure 

estimates the probability that orbital debris impacts will cause components critical to postmission 

disposal to fail. If this estimate shows that there is a significant probability of failure, a full 

penetration analysis should be conducted to guide any redesign and to validate any shielding design. 

 

Note: This module is computationally intensive and may require many minutes or hours to 

complete. For each year of the mission (duration), DAS computes penetration probability over a full 

range of particle speeds and impact angles. 

 

Note: Users seeking to evaluate penetration probability due to meteoroid flux must use 

NASA’s MEM software tool; they are encouraged to contact the NASA Meteoroid 

Environment Office or the Orbital Debris Program Office. 
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3.6 Requirement 4.6-1, 4.6-2, 4.6-3: Postmission Disposal of Space Structures 
 

NASA space programs and projects are to plan for the disposal of a structure (i.e., launch vehicle 

components, upper stages, spacecraft, and other payloads) at the end of their respective missions. 

Postmission disposal is used to remove a space structure from Earth orbit in a timely manner or to 

leave a space structure in a disposal orbit where the structure will pose as small a threat as practical 

to other space systems.  

 

A space structure shall be disposed of by one of the following options: (1) natural reentry, direct 

reentry, or direct retrieval; (2) storage or Earth escape; or (3) long-term reentry. 

 

Requirement 4.6 is divided into the following four postmission disposal categories: 

• 4.6-1 – Natural reentry, direct reentry, or direct retrieval: A spacecraft or orbital stage 

planning for atmospheric reentry or direct retrieval.  

• 4.6-2 – Storage and Earth escape: A spacecraft or orbital stage planning to use the MEO or 

GEO storage options, or using a direct Earth-escape trajectory.  

• 4.6-3 – Long-term reentry for structures in MEO, Tundra orbits, highly inclined GEO, and 

other orbits: A spacecraft or orbital stage planning to exploit natural resonances to increase 

eccentricity over time to reenter the atmosphere within 200 years postmission. 

• 4.6-4 – Reliability of postmission disposal maneuver operations in Earth orbit is not 

addressed by DAS. 

 

Upon selection of Requirement 4.6, all payloads and rocket bodies defined in the Mission Editor are 

categorized (by altitude region), assessed, and displayed in a corresponding grid. Because of the 

variety of possible inputs for Requirement 4.6-3, the user desiring the long-term reentry option must 

specify this option by selecting the “Long-Term Reentry” check-box for the object in the Mission 

Editor. 
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Figure 3–8: Requirements 4.6-1, 4.6-2, 4.6-3: Postmission Disposal of Space Structures Dialog 

 
Input Data: 

 

Launching Requirement 4.6 will categorize all payloads and rocket bodies defined in the Mission 

Editor by requirement region, then run the assessment. The structures are then displayed in a 

corresponding grid.  

 

• Requirement 4.6-1 – Natural reentry, direct reentry, or direct retrieval. 

• Requirement 4.6-2 – Storage and Earth escape. 

• Requirement 4.6-3 – Long-term reentry for structures in MEO, Tundra orbits, highly 

inclined GEO, and other orbits. 

The input data displayed in the grid are “read-only.” To modify the input data, the user must return 

to the Mission Editor’s Define Payload Properties or Define Rocket Body Properties grid. 
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Output Data: 

 

This dialog analyzes each payload or rocket body defined for the mission and assesses its disposal 

compliance based on its orbital definition. If the user inputs an invalid storage orbit, DAS will 

assess it based on the natural reentry option. 

 

Compliance status is returned for each payload and rocket body. If a space structure is non-

compliant, DAS provides a Suggested Perigee and Apogee Altitude (km) next to the compliance 

status in the requirement grid, which may help the mission designer determine the magnitude and 

direction of the non-compliance. All other entries are input fields from the Mission Editor. 

 

The fields labeled PMD Perigee Altitude and PMD Apogee Altitude are computed for objects 

without a specified PMD maneuver. This is the case for rocket bodies and payloads that are 

abandoned at their end-of-mission. If an object is abandoned at the end of its mission, then its PMD 

altitudes are set to its end-of-mission altitudes. For station-kept objects these are the same as the 

operational altitudes. For non-station-kept and abandoned objects the end-of-mission orbit is found 

by propagation. This is the reason the two fields PMD Perigee Altitude and PMD Apogee 

Altitude may have different values than those input by the user. 

 

Messages and comments developed during analysis are displayed on the dialog, below the output 

data. Non-compliant items are listed by requirement in the message area of the dialog along with a 

reason for non-compliance. If any items are non-compliant, Requirement 4.6 fails assessment.  

 

3.7 Requirement 4.6-4: Postmission Disposal Reliability 

 

DAS cannot assess compliance with Requirement 4.6-4. The project must demonstrate compliance 

with Requirement 4.6-4 though its own calculations. For assistance with Requirement 4.6-4, contact 

the NASA Orbital Debris Program Office. 

 
 

3.8 Requirement 4.7-1: Casualty Risk from Uncontrolled Reentry 
 

NASA space programs and projects that use atmospheric reentry as a means of disposal for space 

structures need to limit the amount of debris that can survive reentry and pose a threat to people on 

the surface of Earth. This area applies to full spacecraft as well as jettisoned components and 

NASA-associated hardware carried on non-NASA vehicles. This section of DAS assesses 

compliance with Requirement 4.7-1a, which addresses risk from uncontrolled reentry. DAS does 

not address concerns related to controlled reentry (Requirements 4.7-1b and 4.7-1c). 

 

The potential for human casualty is determined for objects returning to Earth’s surface with a 

kinetic energy exceeding 15 joules. The expected debris casualty area is based on the quantity of 

each surviving object multiplied by its casualty area. The casualty risk is the product of the total 

expected debris casualty area, and the statistical population density is based on the orbital 

inclination and the year of return. World population densities have been computed up to the year 

2100. The risk from any potential reentry beyond that year will need to be computed outside DAS. 

For reference, see:  
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Opiela, J.N., and M.J. Matney, “Improvements to NASA's Estimation of Ground Casualties from 

Reentering Space Objects,” Space Debris and Space Traffic Management Symposium, AAS 

Science and Technology Series, vol. 109, p. 385-392, 2004. 

Ostrom, C.L., “Improving Estimation of Ground Casualty Risk from Reentering Space Objects,” 9th 

International Association for the Advancement of Space Safety Conference, Toulouse, 2017. 

To calculate the risk of human casualty, the arrangement of each space structure element needs to 

be defined to assess its reentry survival potential. An example of the nested “parent-child” 

relationship is shown in Figure 3-9. The parent object (i.e., the spacecraft) is depicted at step “A” in 

the figure; it contains three main subcomponents, or “children.” Based on empirical and theoretical 

data, the outermost structure (i.e., the “parent” object) is assumed to break apart at an altitude of 

78 km. The first level of “child” objects is exposed at this point, labeled “B.” The child objects are 

then subjected to the various forces of the reentry model. If a child object is destroyed (“demises,” 

shown as a dotted line) due to the reentry forces, it does not contribute to the final casualty area 

calculation. If a child object contains further levels of children, those children are exposed at the 

same point at which their immediate parent object demises (point “C”). Objects that survive the 

most intense reentry forces have reached their terminal velocity and begin to cool as they approach 

the ground (point “D”). This process allows a realistic progression of the exposure of nested 

structures. 

 

 

Figure 3–9: Parent-child Relationship of Nested Components in the DAS Reentry Assessment. 

 

Note that the DAS reentry model includes neither pre-heating of internal structures nor partial 

ablation. The lack of pre-heating means that each level of children is exposed with the same starting 
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temperature of 300 kelvins. The lack of partial ablation means that an exposed structure’s 

cross-sectional area is either zero (demised) or is the usual product of the initial dimensions. 

 

Any spacecraft with a total risk of human casualty less than 0.0001 (1:10,000) will be identified as 

compliant. 

 

This part of DAS is intended to be a “first cut” assessment tool, providing somewhat conservative 

results. That is, DAS will classify as non-compliant all missions that clearly do not satisfy this 

requirement of NASA-STD-8719.14C but may also classify as non-compliant some missions that 

are borderline compliant. For this reason, missions that fail the DAS reentry assessment may require 

a more thorough, higher-fidelity analysis than DAS can provide. Such issues must be resolved 

during the mission design and ODA review processes. 

 

Best Practices for Reentry Analysis 

 

Performing reentry analyses in DAS can be challenging, even for highly experienced users. New 

missions with multiple smallsats can cause a large workload for analysts. The following practices 

will ensure the best results for DAS reentry analysis and are the best way to verify compliance. 

 

Inclusion of Components in the Model 

 

• At least 90% of the total reentry mass of the satellite (or hosted payload) should be 

represented by the listed components unless there are good reasons this is either not 

possible or not applicable. For example, if a significant fraction of the mass consists of 

components smaller than 10g, or if some components are in early design phase, then less 

than 90% modeled mass may be used. 

• Ensure all components greater than 50g in mass are included in the parts list, regardless 

of material. 

o For large numbers of components, the reentry.csv file can be edited in Excel or 

your editor of choice, then imported in DAS when complete. 

o In DAS 3, up to 2500 components can be modeled in a single DAS run. This 

would allow up to, for example, 100 CubeSats each with 25 components. 

• Components smaller than 10 grams are typically of little concern and do not need to be 

included in an analysis. 

o Even for extremely high-density materials, these components are highly unlikely 

to reach 15 joules of kinetic energy at impact. 

o DAS assesses the computed density of an object (i.e., the input mass divided by a 

computed volume of the shape) and compares it to the tabulated material density. 

DAS will give an error if an object’s computed density is more than 5% higher 

than the constituent material’s density. 

• Small and high quantity components like fasteners should not be modeled as an 

“equivalent mass” object. If the exact quantity or sizes are not known, it is better to 

define the components with an approximate size and quantity. 

Choosing a Component Shape 
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• Components that have one dimension that is smaller than about 10% of the other two 

should be modeled as flat plates. 

o For example, if an object is 0.4×0.4×0.05m in size, this should be modeled as a 

flat plate. 

o Something that is 0.4×0.4×0.1m in size may be better modeled as a box. 

• Components with two dimensions that are similar and one that is ~1.5x larger should be 

modeled as a cylinder. 

o Most components will end up tumbling during reentry; square tubes will appear 

somewhat circular in terms of aeroheating and drag under these conditions. Even 

moderately rectangular components may be best modeled as cylinders with the 

same hydraulic diameter (4×area/perimeter). 

o If an object has all three dimensions similar in magnitude, it is best modeled as a 

box, or potentially even a sphere. 

Nesting Components 

In general, a component that is attached to another distinct, larger component should be modeled as 

a “child” object of the larger component if the following conditions are met: 

• The aerodynamic properties of the combination of the two components are approximately 

equal to those of the larger component. 

• The direct aerothermal heating of the smaller component is eliminated or greatly curtailed 

by the presence of the larger component. 

• Neither of the previous two conditions are likely to change until the larger component is 

destroyed. 

These principles can be illustrated with some example configurations: 

• If an assembly sub-component is fully enclosed within another assembly component, then 

the sub-component should be modeled as a child object of the enclosing component. 

Examples include battery cells (children) within the battery enclosure (parent) and a 

reaction wheel (child) within the reaction wheel housing (parent). This is the simple 

configuration shown in Figure 3-9. 

• If a component is attached to, and mostly shielded by, a larger structure, even if the 

structure doesn’t necessarily “contain” the component, then the component should be 

modeled as the child object of the structure. Examples include battery cells (children) 

within a matrix structure (parent) and avionics boxes (children) mounted on the inside of 

an aluminum enclosure (parent) that is open on one end. 

• If a component is attached to a large flat panel or to the outside of an enclosure and the 

melting temperature of the smaller component is higher than that of the larger component, 

then it is likely the smaller component will not demise before the larger, and it should be 

modeled as a child object of the larger component. 
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Figure 3–10: Requirement 4.7-1 Limit the Risk of Human Casualty Dialog 

 

Input Data: 

 

The subcomponents and their relationships within each element are defined in a “reentry objects 

tree.” Objects subject to reentry are provided as root objects, based on a project’s rocket body, 

payload, and mission debris data entered in the Mission Editor. All subcomponents of these objects 

should be defined for assessment of potential risk of human casualty. 
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When a mission object is selected, comments are displayed for that object within the Input 

Comments field (next to the objects tree). The inclination angle defined within the Mission Editor 

is displayed in the Input Comments. A warning is displayed if the mass of defined subcomponents 

does not define at least 95% of the object’s mass. These comments do not display when 

subcomponent objects are selected. 

 

The quantity of an item is the total quantity of that uniquely named item within the parent object. 

Items with a quantity multiplier (other than 1) must be physically identical and must be at the same 

level in the parent-child tree, e.g., the quantity multiplier cannot be used for identical items enclosed 

within non-identical assemblies. When any component is selected, a warning will be displayed if 

the defined quantity is not a multiple of the quantity of its immediate “parent” object. Also listed 

will be any immediate subcomponents of the selected object that do not have quantities that are 

multiples of the object’s quantity. Specifying the correct quantity is important because the debris 

casualty area is based on the quantity of each surviving object multiplied by its casualty area. That 

is, DAS does not compound the number of child objects based on the number of identical parent 

objects; the user specifies the total quantity of each item within the parent object. 

 

Each component is defined using the quantities shown in Table 3-3. 

 

Table 3-3: Requirement 4.7-1 Subcomponent Input Grid 

Name Unique textual name for the component. 

Quantity Integer quantity. 

Material Type Textual material type. A drop-down alphabetic list of defined 

materials in the Material Database (DB) (including “user” 

materials) for this project. The materials can be selected from the 

list or typed in. If the typed material is not found in the Material 

DB, the edit will not be accepted. (See Sect. 2.5 for Material DB). 

Object Shape Shape of the element. A drop-down list of acceptable shapes: 

Sphere, Cylinder, Flat Plate, Box. Any other typed word will not 

be accepted. Object Shape must be defined before the 

subsequent inputs (which vary based on Object Shape). 

Thermal Mass Mass of each element in kilograms. Thermal mass does not 

include the mass of defined subcomponents. 

Diameter/Width The diameter of sphere and cylinder objects, or width of flat plate 

and box objects, in meters. Must be greater than or equal to 

Height. 

Length The length of cylinder, flat plate, and box objects, in meters. 

Must be greater than or equal to Diameter or Width. 

Height  The height of box objects, in meters. 

The dimension data are editable based on the body type selected for each element. 

 

Subcomponents are defined using the “Add Sub-Item” button. A new element will be added as a 

subcomponent to the currently selected item with a unique label based on New Component. A row 

is added below the current item in the Component Data grid for the new item. As items within the 

reentry objects tree are selected, the corresponding row in the grid is selected for data entry. The 
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name can be edited within the component data grid. Entering a new name that is used on another 

object within the grid will fail and the name will remain unchanged until a unique name is entered. 

To view and edit large lists of components, use the vertical and horizontal scroll bars attached to the 

Input (component tree) and the Component Data input areas.  

 

 

Note: The mission elements’ data, defined within the Mission Editor, are not available for update 

within this dialog.  

 

The structure of a mission element can be defined by adding each subcomponent and its sub-items 

individually. The data can also be imported from a comma-separated-values (CSV) text file created 

in the same format as the project’s reentry file by selecting the Import Sub-Items button. The data 

must contain the quantities listed in Table 3-4. The first row of the file is assumed to contain 

column headers. 

 

Table 3-4: Requirement 4.7-1 Comma-separated Subcomponent File Format 

ID  Integer row number, beginning with 1. 

Name Unique textual name for the component. 

Parent  Row number for this item’s parent component. The root 

element must be defined on row 1 with a parent of 0. 

Qty Integer quantity. 

Material Textual material type – this is validated against the Material DB 

defined for this project. If the given material is not defined in 

this project, the material will be left blank and require selection 

within the dialog. 

Body Type Shape of the element. Valid body types are Sphere, Cylinder, 

Flat Plate, and Box. 

Thermal Mass Mass of the element in kilograms, not including defined 

subcomponents. 

Diameter/Width The diameter of sphere and cylinder objects, or width of flat 

plate and box objects, in meters. Must be greater than or equal 

to Height. 

Length The length of cylinder, flat plate, and box objects, in meters. 

Must be greater than or equal to Diameter or Width. 

Height  The height of box objects, in meters. 
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Spreadsheet software (such as Microsoft’s Excel) can load and save CSV’s in a text file, which it 

gives the extension “.csv”.   In Excel, to save a single “worksheet” as a .csv file, select “Save As” 

from the File Menu. In the Save As file selection dialog, click on the pull-down selection menu 

labeled “Save as type,” and scroll down to the option “CSV (Comma delimited) (*.csv).” Give the 

file a name and click on the “Save” button. Note that Excel does not add trailing commas to delimit 

blank data cells beyond the last filled column but will add extra commas to pad short lines up to the 

last filled column. This may cause errors in DAS by shortening some input lines and extending 

others. Short rows may need to be manually edited (using a text editor) to add the commas 

delimiting trailing blank cells and to delete extra commas from extended rows. The user will find it 

instructive to first view and edit the file (“reentry.csv”) created by DAS using a plain-text editor. 

Note that a Windows or DAS error may result if the user opens DAS data files while DAS is 

running. 

 

Selecting the “Import Sub-Items” button will display the Open File dialog. Select the input file 

from its current directory location and select “OK.” The data will be read from the selected file and 

added to the reentry objects tree and the Component Data grid. Imported data will be saved in the 

project\reentry.csv file. Names that are not unique will be empty within the grid and must be 

renamed before the data can be assessed. Editing the name within the grid will change the name 

within the tree. 

 

A selected subcomponent and its defined elements can be deleted with the “Delete” button. The 

user will be prompted to confirm that the item and its contents are to be deleted. The delete button is 

disabled when a mission element is selected.  

 

All required data defined in the component grid are validated when the “Run” button is selected. 

Data validity is based on the following: 

• All required fields have been entered for each object. 

• For components with multiple dimensions, the values must be entered such that Length ≥ 

Width ≥ Height. 

• Defined mass does not exceed a limit determined by the material density and the object’s 

dimensions (i.e., mass ≤ density×volume).  

Note: The computed density for a flat plate is based on a height of one-tenth the width. A 

thicker plate, or one which does not pass input validation, should be modeled as a box. 

• A cylinder must have a length of at least 30% of its diameter. If its length is less than 10% of 

its diameter, then define the component as a flat, square plate of equivalent area. If its length 

is between the 10% and 30% limits, then the component may be approximated as a box with 

equivalent area. 

If any of the data are not valid, the assessment ceases and the dialog selects the invalid object. The 

data must be corrected before the process can continue. 

 

Output Data: 

 

Output data will provide information (see Table 3-5) on compliance of each mission element. 
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Table 3-5: Requirement 4.7-1 Mission Element Output Data 

Object Name The name defined within the Mission Editor for 

objects determined to qualify for reentry analysis. 

Compliance Status The result of analysis: Compliant or Non-Compliant. 

Non-Compliant data will be highlighted in red text. 

Risk of Human Casualty The computed results are displayed in 1:nnn format. 

Any risk larger than 1:10,000 will result in non-

compliance. For objects that use the Long-Term 

Reentry option or that do not reenter within the DAS 

propagation period, the compliance status is stated as 

relative to the Debris Casualty Area limit. 

Total Debris Casualty Area The sum of debris casualty area for all subcomponents 

possessing kinetic energy greater than 15 joules. 

 

The displayed data for subcomponents and mission elements without subcomponents is shown in 

Table 3-6. 

 

Table 3-6: Requirement 4.7-1 Subcomponent Output Data 

Subcomponent Object The name provided for the subcomponent object. 

Demise Altitude Predicted demise altitude in kilometers. Altitude of 

zero (0) indicates surviving debris expected to impact 

Earth. 

Total Debris Casualty Area Predicted casualty area of debris in square meters. 

Objects demising above Earth’s surface will have a 

debris casualty area of zero (0).  

Kinetic Energy The impact kinetic energy in joules.  

 

Messages and comments developed during analysis are displayed on the dialog, below the output 

data. The user should press the “Reset” button in the top-level Requirement Assessments dialog 

window before editing the inputs for this Requirement for making additional assessment runs. 

 

When the project is saved, all input and output data for this dialog are saved in the 

project\reentry.csv file.  

 

 

3.9  Requirement 4.8-1: Special Classes of Space Missions 
 

Special classes of space missions, including large constellations; rendezvous, proximity operations, 

and satellite servicing; safety of active debris removal operations; tethers; and small satellites shall 

comply with requirements in Sections 4.3 through 4.7 of NS 8719.14C. DAS 3 will not assess 

compliance with additional conditions of Requirement 4.8-1. The project must demonstrate 

compliance with this Requirement though its own calculations. Contact the NASA Orbital Debris 

Program Office for assistance.  
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 4. Science and Engineering Utilities 
 

The Science and Engineering utilities are intended to answer questions of general interest for debris 

assessments that might or might not also be covered in the specific requirement areas. In the left 

windowpane of the GUI, preceding each section of the Science and Engineering utilities tree, is an 

image. Utilities with a flask image  allow calculations. Descriptive levels of the tree are denoted 

by a page  image. Expand the folder levels by depressing the adjacent plus , revealing the 

calculating utilities. 

 

Utilities that make heavy use of ORDEM have been removed from DAS 3 due to the impractically 

long runtimes. 

 

 

 

4.1 Analysis of Postmission Disposal Maneuvers 
 

These Science and Engineering utilities may assist users in the assessment of compliance with 

Requirement 4.6, the “postmission disposal of space structures.” These utilities address orbital 

maneuvers necessary for disposal by atmospheric reentry or potential storage orbits above LEO. 

 

Three utilities are available within this group. Disposal by Atmospheric Reentry is a plotting 

utility that plots disposal Delta-V contours as a function of Initial Perigee and Initial Apogee. 

Maneuver to Storage Orbit calculates First Burn, Second Burn, and the Total Delta-V required to 

reach the minimum acceptable storage orbit. Reentry Survivability Analysis provides this 

function, self-contained and separate from an actual mission assessment. 
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4.1.1 Disposal by Atmospheric Reentry 

 

This utility plots contours of Delta-V corresponding to the Delta-V required to move from LEO to a 

decay orbit with a user-specified lifetime. This may aid the user in determining the cost of deorbit 

maneuvers. Users should specify at least one Delta-V contour value. Figure 4-1 shows the input 

dialog, and Table 4-1 describes the values. 

 

 

 

Figure 4-1: Disposal by Atmospheric Reentry Input Dialog 
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Table 4-1: Disposal by Atmospheric Reentry Input Data 

Start Year Marks the beginning date (in decimal form) for the period 

currently under study. The input value must be a positive 

numeric value equal to or greater than 2016 and less than or 

equal to 2130. In addition, the sum of the Start Year and Decay 

Orbit Lifetime must not exceed the year 2200. 

Decay Orbit Lifetime The length of the orbital lifetime, beginning at the Start Year. 

It is required to be in years (decimal years are acceptable). 

This input value must be a positive, numeric value greater than 

zero. In addition, the sum of the Start Year and Decay Orbit 

Lifetime must not exceed the year 2200. 

Area-to-Mass The object’s average cross-sectional area (m2) divided by its 

final mass (kg). A positive, numeric value is required, and a 

decimal value is acceptable.  

Delta-V Each contour value is entered into the edit box below the list. 

Once entered, the user clicks the “Add” button to load the 

value into the list.  

The user may remove a previously defined contour value by 

highlighting the value and clicking the “Remove” button. The 

maximum number of entries is 20. Each entry must be a 

positive, numeric value, and decimal values are acceptable. 

Units are m/s. 

 

The “Plot” button will send input values from the dialog to the calculating routines. As the utility 

processes the data, a Processing dialog will appear. Plot processing may take several minutes. To 

cease processing, depress the “Stop” button on the dialog. 

 

The calculating routines will produce a plot of returned points. If no points are returned, a warning 

message will be generated, requiring the user to click the “OK” button to continue.  

 

The “Reset” button will clear all input values from the dialog.  

 

Output Data: 

 

The generated plot is viewable in a separate plot window. The user can find the disposal Delta-V 

requirement for any low Earth orbit by pairing perigee and apogee values from the plot axes. On the 

plot, Delta-V increases from the bottom and left toward the top and right. Note that, by definition, 

no values exist above the 1:1 boundary line. See Figure 4-2 for an example plot. Section 2.6, Using 

the Plot Viewer, provides information on plot utility functions.  
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Figure 4-2: Disposal by Atmospheric Reentry 

 

 

4.1.2 Maneuver to Storage Orbit 

 

This utility calculates the minimal storage orbit and the Delta-V required to maneuver from the 

object’s initial orbit to that storage orbit using a two-burn, minimum-energy transfer orbit. This may 

aid the user in determining the cost of a storage orbit maneuver. Figure 4-3 shows the input/output 

dialog, and Tables 4-2 and 4-3 describe the input and output values. 
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Figure 4-3: Maneuver to Storage Orbit Dialog 
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Table 4-2: Maneuver to Storage Orbit Input Data 

Perigee Altitude The perigee altitude (in kilometers) for the object currently 

under study, immediately before the maneuver to storage orbit. 

The input value must be a positive numeric value greater than 90 

and less than or equal to 100,000. In addition, the perigee 

altitude must be less than or equal to the apogee altitude. 

Apogee Altitude The apogee altitude (in kilometers) for the object currently under 

study, immediately before the maneuver to storage orbit. The 

input value must be a positive numeric value greater than 90 and 

less than or equal to 100,000. In addition, the apogee altitude 

must be equal to or greater than the perigee altitude. 

Area-To-Mass The object’s average cross-sectional area (m2) divided by its 

final mass (kg). The input value must be a positive numeric 

value greater than or equal to 0.00001 (m2/kg) and less than or 

equal to 1000 (m2/kg).  

 

This value is only required when all or part of the orbit resides in 

the range of GEO ± 200 km. 

 

The “Run” button sends the user input to the calculating routines. If input values are valid, the 

output fields will display the calculated results. Messages and comments developed during 

calculation are displayed on the dialog, below the output data. 

 

The “Reset” button clears all input values from the dialog. 
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Table 4-3: Maneuver to Storage Orbit Output Data 

Storage Orbit – Perigee 

Altitude 

The suggested storage orbit perigee required to minimally 

satisfy the postmission disposal requirement.  

Storage Orbit – Apogee 

Altitude 

The suggested storage orbit apogee required to minimally 

satisfy the postmission disposal requirement.  

Transfer Orbit – Perigee 

Altitude 

The calculated perigee altitude attained after Delta-V (first 

burn).  

Transfer Orbit – Apogee 

Altitude 

The calculated apogee altitude attained after Delta-V (first 

burn). 

First Burn Delta-V The Delta-V required to place the object on the minimum-

energy transfer orbit connecting the initial and storage orbits. 

Second Burn Delta-V The Delta-V required to move the object from the transfer 

orbit to the storage orbit. 

Total Delta-V The Delta-V required to maneuver the object from initial to 

disposal orbit, using a two-burn, minimal energy transfer. 

This quantity represents the sum of the first and second burn 

Delta-V’s. 

Message The possible returned messages include the following: 

• No associated message for object 

• Input orbit parameters do not satisfy any storage 

categories 

• Initial perigee is low enough that user should 

consider disposal by atmospheric reentry 

• Initial orbit is in (non-semi-synchronous) medium 

Earth orbit; no disposal maneuver is necessary 

 

 

4.1.3 Reentry Survivability Analysis 

 

This utility provides a tool to study reentry survivability without changing the input characteristics 

of the actual mission (as specified in the Mission Editor). A single object and its subcomponents can 

be assessed, rendering the demise altitude, total debris casualty area, and kinetic energy for each 

item.  

 

Based on empirical and theoretical data, the outermost structure (i.e., the “parent” object) is 

assumed to break apart at an altitude of 78 km. The first level of “child” objects is exposed at this 

point. The objects are then subjected to the various forces of the reentry model. If a child object is 

destroyed (“demises”) due to the reentry forces, it does not affect the final casualty area calculation. 

If a child object contains further levels of children, those children are exposed at the same point at 

which their immediate parent object demises. This process allows a more realistic progression of the 

exposure of nested structures. 

 

This utility supports the definition of a single object and its subcomponents. See Table 3-3 

(Sect. 3.9) for a description of the input data. Figure 4-4 shows the input dialog, and Table 4-4 

describes the output values. 
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Figure 4-4: Reentry Survivability Analysis Dialog 
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Output Data: 

 

The displayed data for the root element and its subcomponents’ survivability is shown in Table 4-4. 

Note that since the root object is assumed to break up at 78 km, its output will only contain the sum 

of its subcomponent’s debris casualty area. 

 

 

Table 4-4: Reentry Survivability Output Data 

Sub-component Object The name provided for the subcomponent object. 

Demise Altitude Predicted demise altitude in kilometers. An altitude of 

zero (0) indicates surviving debris is expected to 

impact Earth. 

Total Debris Casualty Area Predicted casualty area of debris in square meters. 

Objects demising above Earth’s surface will have a 

debris casualty area of zero (0).  

Kinetic Energy The impact kinetic energy in joules.  

 

 

 

 

4.2 Orbit Evolution Analysis 
 

These Science and Engineering utilities may assist users in the assessment of compliance with 

Requirement 4.6, the “postmission disposal of space structures.”  

 

Two utilities are available within this group. Apogee/Perigee Altitude History for a Given Orbit 

is a plotting utility that plots Apogee/Perigee History over time. Orbit Lifetime/Dwell Time 

calculates Orbit Lifetime and LEO Dwell Time, and the final year of propagation. 
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4.2.1 Apogee/Perigee Altitude History for a Given Orbit 

 

This utility creates a predicted “history” of Perigee and Apogee Altitudes for the user-entered orbit 

elements. The output of this utility is a plot of Altitude (in kilometers) along the vertical axis and 

Time (in years) along the horizontal axis. For LEO objects, the plot may indicate the orbital decay 

rate and reentry date. Figure 4-5 shows the input dialog, and Table 4-5 describes the values. 

 

 

Figure 4-5: Apogee/Perigee Altitude History for a Given Orbit Input Dialog 
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Table 4-5: Apogee/Perigee Altitude History for a Given Orbit Input Data 

Perigee Altitude The perigee altitude (in kilometers) for the object currently 

under study. The input value must be a positive numeric 

value greater than 90 and less than or equal to 100,000. In 

addition, the perigee altitude must be less than or equal to the 

apogee altitude. 

Apogee Altitude The apogee altitude (in kilometers) for the object currently 

under study. The input value must be a positive numeric 

value greater than 90 and less than or equal to 100,000. In 

addition, the apogee altitude must be greater than or equal to 

the perigee altitude. 

Inclination The orbital inclination angle. Positive, numeric degrees 

between zero and 180 (inclusive). Decimal numbers are 

accepted. 

R.A. of Ascending Node Right Ascension of Ascending Node (RAAN) must be a 

positive numeric value (in degrees) greater than or equal to 0 

and less than or equal to 360. Decimal entries are valid. 

Although all input fields are required, entry into this field 

will not affect the calculations when the apogee altitude is 

less than 2000 km. 

Argument of Perigee A positive numeric value (in degrees) greater than or equal 

to 0 and less than or equal to 360. Decimal entries are valid. 

Although all input fields are required, entry into this field 

will not affect the calculations when the apogee altitude is 

less than 2000 km.  

Mean Anomaly Positive numeric value (in degrees) greater than or equal to 0 

and less than or equal to 360. Decimal entries are valid. 

Although all input fields are required, entry into this field 

will not affect the calculations when the apogee altitude is 

less than 2000 km.  

Area-To-Mass Ratio The object’s average cross-sectional area (m2) divided by its 

final mass (kg). The input value must be a positive numeric 

value greater than or equal to 0.00001 (m2/kg) and less than 

or equal to 1000 (m2/kg). Decimal entries are valid.  

Start Year The beginning date (in decimal years) for the period 

currently under study. The input value must be a positive 

numeric value equal to or greater than 2016 and less than or 

equal to 2130. In addition, the sum of the Start Year and the 

Integration Time must not exceed the year 2200. 

Integration Time The length of time (decimal years) desired for propagation. 

This input value must be a positive numeric value greater 

than zero. In addition, the sum of Integration Time and Start 

Year must not exceed 2200. 
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The “Reset” button will clear all input values from the dialog. 

 

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the 

utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop” 

button on the dialog. 

 

If no points are calculated, a message box will appear notifying the user. The user must then select 

“OK” to exit the message box. 

 

Output Data: 

The generated plot is viewable in a separate plot window. See Figure 4-6 for an example plot. 

Section 2.6, Using the Plot Viewer provides information on plot utility functions.  

 

 

Figure 4-6: Apogee/Perigee Altitude History for a Given Orbit 

 

 

  



 

55 

 

4.2.2 Orbit Lifetime/Dwell Time 
 

This utility calculates the Orbital Lifetime and LEO Dwell Time of an object in a specified orbit. 

These values relate directly to the assessment of the Requirements imposed on LEO debris. The 

Message area (below the Output area) of the dialog will display a message to users upon process 

completion. Figure 4-7 shows the input/output dialog. The input and output values are described in 

Tables 4-6 and 4-7, respectively. 

 

 

Figure 4-7: Orbit Lifetime/Dwell Time Dialog 
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Table 4-6: Orbit Lifetime/Dwell Time Input Data 

Start Year The beginning date (in decimal years) for the period 

currently under study. The input value must be 

positive, numeric, and fall in the range of 2016-2100. 

Perigee Altitude The perigee altitude (in kilometers) for the object 

currently under study. The input value must be a 

positive numeric value greater than 90 and less than or 

equal to 100,000. In addition, the perigee altitude must 

be less than or equal to the apogee altitude. 

Apogee Altitude The apogee altitude (in kilometers) for the object 

currently under study. The input value must be a 

positive numeric value greater than 90 and less than or 

equal to 100,000. In addition, the apogee altitude must 

be greater than or equal to the perigee altitude. 

Inclination The orbital inclination angle. Positive, numeric 

degrees between 0 and 180 (inclusive). Decimal 

numbers are accepted. 

RAAN RAAN must be a positive numeric value (in degrees) 

greater than or equal to 0 and less than or equal to 360. 

Decimal entries are valid. Although all input fields are 

required, entry into this field will not affect the 

calculations when the apogee altitude is less than 

2000 km. 

Argument of Perigee A positive numeric value (in degrees) greater than or 

equal to 0 and less than or equal to 360. Decimal 

entries are valid. Although all input fields are required, 

entry into this field will not affect the calculations 

when the apogee altitude is less than 2000 km.  

Area-to-Mass The object’s average cross-sectional area (m2) divided 

by its final mass (kg). The input must be a positive 

numeric value greater than or equal to 0.00001 (m2/kg) 

and less than or equal to 1000 (m2/kg). Decimal entries 

are valid. 

 

The “Reset” button will clear all input from the dialog. 

 

The “Run” button sends the user input to the calculating routines. If input values are valid, the 

output fields will display the calculated results. Messages and comments developed during 

calculation are displayed on the dialog, below the output data. 
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Output Data: 

 

Table 4-7: Orbit Lifetime/Dwell Time Output Data 

Calculated Orbit Lifetime Orbital Lifetime is calculated from the Start Year. 

Calculated Orbit Dwell Time The time spent in LEO during Orbital Lifetime. 

Last Year of Propagation The year that the object either reentered or exceeded the 

propagation time limit. 

Messages The message area displays a textual message after 

completion of “Run.” 

The possible returned messages include the following: 

• No associated message for object. 

• Object will remain in orbit and above LEO for 

the foreseeable future (>100 years). 

o NOTE: The orbit is NOT processed. 

• Object reentered. 

• Object did not reenter within the maximum years 

of propagation. 

 

 

4.3 Delta-V for Postmission Maneuver 
 

These Science and Engineering utilities may assist users in the assessment of compliance with 

Requirement 4.6, the “postmission disposal of space structures.” These utilities calculate the change 

in velocity required for maneuvers needed to achieve atmospheric reentry within 25 years. 

 

Two utilities are available within this group. Delta-V for Decay Orbit Given Orbital Lifetime 

plots area-to-mass contour points corresponding to the Delta-V required to move an object, with a 

specified orbital lifetime, from an initial circular LEO orbit to a decay orbit. The user specifies a list 

of area-to-mass contour values. Delta-V for Decay Orbit Given Area-To-Mass plots lifetime 

contour points corresponding to the Delta-V required to move an object, with a specified area-to-

mass ratio, from an initial circular LEO orbit to a decay orbit.  

 

 

4.3.1 Delta-V for Decay Orbit, Given Orbital Lifetime 

 

This utility plots Area-To-Mass ratio contour points corresponding to the Delta-V required to move 

an object from an initial circular LEO to a decay orbit with specified Orbital Lifetime. The user 

specifies a list of Area-To-Mass contour values. The plot allows the user to explore the cost of 

deorbiting a vehicle. Figure 4-8 shows the input dialog, and Table 4-8 describes the values.  
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Figure 4-8: Delta-V for Decay Orbit Given Orbital Lifetime Dialog 

 

 

Table 4-8: Delta-V for Decay Orbit Given Orbital Lifetime Input Data 

Start Year The beginning date (in decimal years) for the period currently under 

study. The input must be a positive numeric value equal to or 

greater than 2016 and less than or equal to 2130. In addition, the 

sum of the Start Year and the Orbital Lifetime must not exceed the 

year 2200. 

Orbit Lifetime The length of time (decimal years) the object is expected to stay in 

orbit. This input value must be a positive numeric value greater 

than or equal to 0.01 and less than or equal to 10,000.0; however, 

the sum of Orbital Lifetime and Start Year must not exceed 2200. 

Area-To-Mass Each Area-To-Mass ratio contour value is entered into the edit box 

below the list. Once entered, the user depresses the “Add” button to 

load the value into the list. The user may remove a contour value by 

highlighting the value in the list and depressing the “Remove” 

button.  

The maximum number of entries is 20. This input must be a 

positive numeric value greater than or equal to 0.0001 (m2/kg) and 

less than or equal to 1000.0 (m2/kg). Decimal values are valid.  

 

The “Reset” button will clear all input values from the dialog. 
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Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the 

utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop” 

button on the dialog. 

 

If no points are calculated, a message box will appear notifying the user. The user must then select 

“OK” to exit the message box. 

 

Output Data: 

The generated plot is viewable in a separate plot window. Delta-V (m/s) is along the vertical axis 

and Altitude (km) is along the horizontal axis. On the plot, A/M increases from the top and left 

toward the bottom and right. See Figure 4-9 for an example plot. Section 2.6, Using the Plot 

Viewer provides information on plot utility functions.  

 

 

 

Figure 4-9: Delta-V for Decay Orbit Given Orbital Lifetime 

 

 

 

4.3.2 Delta-V for Decay Orbit, Given Area-to-Mass  

 

This utility plots Orbital Lifetime contour points corresponding to the Delta-V required to move an 

object, with specified area-to-mass ratio, from an initial circular low Earth orbit to a decay orbit. 
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The user specifies a list of Orbital Lifetime contour values. The plot allows the user to explore the 

cost of deorbiting a vehicle over a range of decay lifetimes. Figure 4-10 shows the input dialog and 

Table 4-9 describes the values. 

 

 

Figure 4-10: Delta-V for Decay Orbit Given Area-To-Mass Dialog 
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Table 4-9: Delta-V for Decay Orbit Given Area-To-Mass Input Data 

Start Year The beginning date (in decimal years) for the period currently under 

study. The input must be a positive numeric value equal to or 

greater than 2016 and less than or equal to 2130. In addition, the 

sum of the Start Year and the Orbital Lifetime must not exceed the 

year 2130. 

Area-To-Mass The area-to-mass ratio is the object’s average cross-sectional area 

(m2) divided by its final mass (kg). The input must be a positive 

numeric value greater than or equal to 0.00001 (m2/kg) and less 

than or equal to 1000 (m2/kg). Decimal entries are valid.  

Orbit Lifetime Each Orbital Lifetime contour value is entered into the edit box 

below the list. Once entered, the user depresses the “Add” button to 

load the value into the list. The user may remove a contour value by 

highlighting the value in the list and depressing the “Remove” 

button.  

The maximum number of entries is 20. The input value must be a 

positive numeric value greater than or equal to 0.01 (yr) and less 

than or equal to 10000.0 (yr); however, the sum of Orbital Lifetime 

and Start Year must not exceed 2130.  

 

 

The “Reset” button will clear all input values from the dialog. 

 

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the 

utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop” 

button on the dialog. 

 

If no points are calculated, a message box will appear notifying the user. The user must then select 

“OK” to exit the message box. 

 

Output Data: 

 

The generated plot is viewable in a separate plot window. Delta-V (m/s) is along the vertical axis 

and Altitude (km) is along the horizontal axis. On the plot, orbital lifetime increases from the top 

and left toward the bottom and right. See Figure 4-11 for an example plot. Section 2.6, Using the 

Plot Viewer provides information on plot utility functions. 
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Figure 4-11: Delta-V for Decay Orbit Given Area-To-Mass 

 

 

4.4 Delta-V for Orbit-to-Orbit Transfer 
 

This Science and Engineering utility may assist users in the assessment of compliance with 

Requirement 4.6, the “postmission disposal of space structures.” This utility calculates the 

minimum change in velocity required to maneuver from one orbit to a second, co-planar orbit. 
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4.4.1 Orbit-to-Orbit Transfer 

 

This utility calculates the Delta-V required for a coplanar orbit transfer. Figure 4-12 shows 

input/output dialog, and Tables 4-10 and 4-11 describe the values, respectively.  

 

 

Figure 4-12: Delta-V for Orbit-to-Orbit Transfer Dialog 
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Input Data: 

Table 4-10: Delta-V for Orbit-to-Orbit Transfer Input Data 

First Orbit Perigee Altitude The perigee altitude (in kilometers) for the object 

currently under study, immediately before the orbit 

transfer maneuver. The input must be a positive 

numeric value greater than 90 and less than or equal 

to 100,000. In addition, the perigee altitude must be 

less than or equal to the apogee altitude. 

First Orbit Apogee Altitude The apogee altitude (in kilometers) for the object 

currently under study, immediately before the orbit 

transfer maneuver. The input must be a positive 

numeric value greater than 90 and less than or equal 

to 100,000. In addition, the apogee altitude must be 

equal to or greater than the perigee altitude.  

Second Orbit Perigee Altitude The final (destination) perigee altitude (in kilometers) 

for the object currently under study. The input must 

be a positive numeric value greater than 90 and less 

than or equal to 100,000. In addition, the perigee 

altitude must be less than or equal to the final apogee 

altitude. 

Second Orbit Apogee Altitude The final (destination) apogee altitude (in kilometers) 

for the object currently under study. The input must 

be a positive numeric value greater than 90 and less 

than or equal to 100,000. In addition, the apogee 

altitude must be equal to or greater than the final 

perigee altitude.  

 

The “Reset” button will clear all input values from the dialog. The “Run” button sends the user 

input to the calculating routines. If input values are valid, the output fields will display the 

calculated results.  

 

Table 4-11: Delta-V for Orbit-to-Orbit Transfer Output Data 

Transfer Orbit Perigee The perigee altitude attained after Delta-V (first burn).  

Transfer Orbit Apogee The apogee altitude attained after Delta-V (first burn).  

Delta-V (First Burn) First Burn Delta-V is the Delta-V required to place the 

object on the minimum-energy transfer orbit connecting 

the first and second orbits.  

Delta-V (Second Burn) Second Burn Delta-V is the Delta-V required to move 

the object from the transfer orbit to the second 

(destination) orbit.  

Delta-V (Total) Total Delta-V is the total Delta-V required to maneuver 

the object from first to second orbit, using a two-burn, 

minimum-energy transfer. This quantity represents the 

sum of the first and second burn Delta-V’s.  
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4.5 Other Utilities 
 

Utilities not directly related to specific requirements are provided to support the definition of data 

related to orbital mechanics. 

 

 

4.5.1 Two Line Element Converter 

 

This utility provides the user with a means to convert a two-line element (TLE) set into orbital 

parameters that can be used in DAS. 

 

 

 

Figure 4-13: Two Line Element Conversion Dialog 

 

Input Data: 

 

The TLE converter has only one input area: the edit box at the top of the window. The TLE text can 

be hand typed, pasted from the clipboard, or loaded from a file. When loading from a file, this 

utility converts only the first two lines of input text. 
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DAS will detect and process the sixty-nine-character TLE. A two-line element set consists of two 

lines of text data, which can be used to determine the position and velocity of an object orbiting 

Earth. Tables 4-12 and 4-13 contain descriptions of the current format of TLE lines 1 and 2. 

Table 4-12: Two-Line Element Set Format Definition, Line 1 

Field Column  Description 

1.1 01 Line Number of Element Data 

1.2 03-07 Satellite Number 

1.3 08 Classification 

1.4 10-11 International Designator (Last two digits of launch year) (Four-digit launch 

year) 

1.5 12-14 International Designator (Launch number of the year) 

1.6 15-17 International Designator (Piece of the launch) 

1.7 19-20 Epoch Year (Last two digits of year) (Four-digit year) 

1.8 21-32 Epoch Day (Day of the year and fractional portion of the day) 

1.9 34-43 One-half the First Time Derivative of the Mean Motion 

1.10 45-52 One-sixth the Second Time Derivative of Mean Motion (decimal point assumed) 

or “AGOM” 

1.11 54-61 BSTAR drag term (decimal point assumed) 

1.12 63 Ephemeris type 

1.13 65-68 Element number 

1.14 69 Checksum (Modulo 10) (Letters, blanks, periods, plus signs=0; minus signs=1) 

 

Table 4-13: Two-Line Element Set Format Definition, Line 2 

Field Column Description 

2.1 01 Line Number of Element Data 

2.2 03-07 Satellite Number 

2.3 09-16 Inclination [Degrees] 

2.4 18-25 RAAN [Degrees] 

2.5 27-33 Eccentricity (decimal point assumed) 

2.6 35-42 Argument of Perigee [Degrees] 

2.7 44-51 Mean Anomaly [Degrees] 

2.8 53-63 Mean Motion [Revs per day] 

2.9 64-68 Revolution number at epoch [Revs] 

2.10 69 Checksum (Modulo 10) 
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Output Data: 

 

 

Figure 4-14: Elements Converted to DAS Input Values 

 

The DAS Input Area displays the values that are obtained from running the TLE Converter. These 

values will be useful for specifying the orbital parameters needed throughout DAS. Note that the 

DAS orbit propagator, designed for long-term propagation, assumes the mission inputs are mean 

orbital elements. 

 

 

4.5.2 Calculate Cross-Sectional Area 

 

This Science and Engineering utility may assist users in estimating the effective cross-sectional area 

of a structure. This quantity is divided by the structure’s mass to produce the area-to-mass ratio, 

used in propagating the orbit for Requirement assessment. 

 

This utility provides a means to create a “wire-frame” model of a spacecraft and to estimate the 

average cross-sectional area of a spacecraft. This cross-sectional area can be used to calculate the 

area-to-mass ratio entry in the DAS Mission Editor. For many projects, this tool will not need to be 

used; it is included here to augment the standard area estimation techniques outlined in the 

NASA-STD-8719.14C. Subsection 4.3.4.1 of the Standard gives simple methods for estimating an 

object’s average cross-sectional area. 

 

The model is constructed using a collection of triangles, cylinders, and spheres. The wire-frame plot 

feature may be used to check for errors in data entry. The cross-sectional area estimation tool is 

intended to provide a basic, but reasonably accurate, estimate of average cross-sectional area. The 

fidelity of the result will depend upon the level of detail provided by the user. Figure 4-15 shows the 

input/output dialog. 
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Figure 4-15: Calculate Cross-Sectional Area Dialog 

 

Input Data: 

 

The user must first define the spacecraft’s orientation as being “random tumbling,” “gravity 

gradient,” or “fixed orientation.” 

• Random tumbling – No axes will be fixed during the orbital lifetime in question. 

• Gravity gradient – The gravity (nadir) direction will be maintained with respect to the 

spacecraft during the orbital lifetime in question. 

• Fixed orientation – The velocity (ram) direction and gravity (nadir) direction will be 

maintained with respect to the spacecraft during the orbital lifetime in question. 

 

For objects that are “gravity gradient” or have “fixed orientation,” the coordinate system shall be 

defined as U, V, and W, where +U is “up” (the opposite direction from gravity), +V is in the 

direction of velocity, and W is “port” (orthogonal: U×V). For “random tumbling” objects, the user 

may choose any convenient coordinate origin and orientation for the UVW system. 

 

Component data are entered into the input grid by typing in any field in the last line of the grid 

(labeled as row “*”). Users input values for shape, point coordinates, and radius as required. The 

units need only be consistent, as the resulting units of area are simply the square of the input length 

(position) units. The model uses a volume centered on the coordinate origin, so large structures and 
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components placed far from the origin will increase both computation time and mathematical 

“round-off error.” Note that this module can process a maximum of 1000 rows. 

 

Component shapes are defined as follows: 

• Triangles – U, V, and W for three corner points are needed. For square or rectangular 

surfaces, two adjoining triangles must be entered. While this is a tedious way to enter the 

data, it is necessary to ensure that each surface remains in a plane, a requirement of the 

cross-sectional area estimation software. For thin plates, such as solar panels, the thickness 

may be ignored. 

• Cylinders – U, V, and W for the center points and radii of each end disk are needed. The 

cylinder may have end disks of different radii. A cone would have one end disk with a 

radius of 0. A flat disk can be entered as cylinder with a minimal distance between the two 

end disks. 

• Spheres – U, V, and W for the center and its radius are needed. 

 

Triangles are two-dimensional, while cylinders and spheres are three-dimensional. Surfaces that are 

interior to another surface will not affect the cross-sectional area estimation. For example, if the 

center point for a sphere is identical to one of the end points for a cylinder, only the portion of the 

sphere that is exterior to the cylinder will be considered. Surfaces that are entirely interior do not 

need to be defined. 

 

If the configuration of the object can change (i.e., moving solar panels), the average of cross-

sectional area over each anticipated configuration may be used, based upon an intelligent 

assumption about the expected time spent in each configuration. 

 

For more detailed projects, the user might find it useful to edit the CSV file xsectional.csv within 

the Project directory, rather than use the GUI. 

 

The “Reset” button will clear all input values from the dialog. 

 

Depressing the “Plot” button sends input values from the dialog to the plotting tool.  

 

The purpose of the plotting tool is to provide a basic “sanity check” of the input values. This visual 

depiction should assist the user in constructing the objects for cross-sectional evaluation, but it is 

not necessary for actual calculation of cross-sectional area. 
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The plotting tool generates three, two-dimensional plots showing the V-W (top), V-U (side), and 

W-U (front) orthogonal views of the triangles, cylinders, and spheres used to define the spacecraft. 

However, because of the difficult nature of showing complex, three-dimensional objects in two-

dimensional plots, there are two basic limitations: 

 

1. To be plotted, the axis of a cylinder (i.e., the line between the centers of the two end disks) 

must be defined in only one or two of the three user-defined UVW directions. If the axis of a 

cylinder varies in the U, V, AND W directions, it will be omitted on the graph. It is 

important to note, the omission does NOT affect the cross-sectional area calculation. All 

cylinders, regardless of their orientation, will be considered when the cross-sectional area is 

estimated. 

2. For visual clarity, all points interior to a perfect cylinder (end disk radii identical) will be 

removed if the axis of the cylinder is in a primary (U, V, or W) direction only. Any cylinder 

axis in two directions or any cylinder with end disks of different radii will not “hide” any 

interior points. All points interior to a sphere will be removed for visual clarity, as well. 

 

Output Data: 

 

Output is the average projected cross-sectional area of the defined object. Output units are the 

square of the input units. 

 

By clicking the “Plot” button, the user may generate a three-view representation of the wire-frame 

model. The generated plot is viewable in a separate plot window. An example of this can be seen in 

Figure 4-16. This is useful for finding data-entry errors that may have occurred during definition of 

the model points. Section 2.6, Using the Plot Viewer provides information on plot utility functions. 
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Figure 4-16: Three-View Cross-Sectional Area Plot 

 

Note: Depending on the size and complexity of the object, the process may take several minutes to 

converge upon a result. 
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Appendix A: Glossary of Terms and Acronyms 
 

 

Aero mass – The aerodynamic mass of an object is the mass of that specific object plus the mass of 

all internal fragments. Consequently, the aero mass must be at least equal to the object’s 

mass. 

 
Altitude – The height above Earth’s surface (distinguished from radius, measured from Earth’s 

center). 
 
Apogee – The point on the orbit that is the farthest from the center of Earth. The apogee altitude is 

the distance of the apogee point above the surface of Earth. 
 
Apsis (pl. apsides) – The point in the orbit where a satellite is at the lowest altitude (perigee) or at 

the highest altitude (apogee). The line connecting apogee and perigee is the line of apsides. 
 
Area-to-Mass ratio (AOM, A/M) – The area-to-mass ratio, which is a measurement of the effective 

cross-sectional area of an orbiting object divided by its mass. Normal units are square meters 
per kilogram. Higher AOM will yield faster decay for LEO objects, while lower AOM (a 
denser object) yields slower decay. AOM should include deployed surfaces (e.g. solar 
panels). 

 
Argument of perigee – The angle between the line extending from the center of Earth to the 

ascending node of an orbit and the line extending from the center of Earth to the perigee 
point in the orbit, measured from the ascending node in the direction of motion of the 
satellite. 

 
Ascending node – The point in the orbit where a satellite crosses Earth’s equatorial plane in passing 

from the southern hemisphere to the northern hemisphere. 
 
Casualty – Serious injury to a person on the surface of Earth, caused by being struck by an object 

with kinetic energy of 15 joules or greater. 
 
Combo box – A GUI component with a drop-down arrow that users click to display an associated 

list of choices. The current selection appears in an editable or noneditable text field next to 
the drop-down arrow. The user displays the list by clicking or dragging the drop-down 
arrow. 

 
Cratering flux – The number of impacts per square meter per year of objects which will leave a 

crater at least as large as a specified diameter. 
 
Critical surface – A surface in a component of a payload that, when the surface is damaged by 

impact, will cause the component to fail. 
 
Debris flux – The number of impacts per square meter per year expected on a randomly-oriented 

planar surface of an orbiting space structure. 
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Debris flux to limiting size – The number of impacts per square meter per year of debris objects of a 
specified diameter or larger. 

 
Delta-V, V – The change in the velocity vector caused by thrust, measured in units of meters per 

second. 
 
Demise – The total destruction of a reentering object, caused mainly by frictional heating with the 

atmosphere. 
 
Dialog – A top-level GUI window, with a title and a border, which is typically used to take some 

form of input from the user. 
 
Disposal orbit – The final orbit of an object after a completed mission. The project may elect to 

alter the end-of-mission orbit via a maneuver to a disposal orbit so that it may satisfy 
Requirement 4.6. 

 
Eccentricity – A measure of an orbit’s ellipticity, calculated as the orbit’s apogee altitude minus its 

perigee altitude, divided by twice its semi-major axis. Eccentricity is zero for circular orbits 
and less than one for all elliptical (i.e., bound) orbits. 

 
F10.7 – An index of solar activity; typically, a 13-month running average of the energy flux from 

the Sun measured at a wavelength of 10.7 cm, expressed in units of 104 janskys or Solar 
Flux Units (sfu). 

 
Final mass – The expected mass after all propellants and fluids have been burned or vented and all 

mission related debris have been released. 
 
Geosynchronous orbit (GEO) – An orbit with a period equal to the sidereal day. A circular GEO 

orbit with 0 inclination is a geostationary orbit, i.e., the sub-satellite point is at a fixed 
longitude on Earth’s equator. The altitude of a circular GEO orbit is 35,786 km.  

 
Geosynchronous transfer orbit (GTO) – A highly eccentric orbit with perigee within or near LEO 

altitude and apogee near or above GEO altitude. 
 
Grid – A GUI control to display the fields of a data source as columns in a table. Each row in the 

control represents a record in the data source.  
 
GUI – Graphical user interface for computer software. The dialog window provided for user 

interface with an application’s functional process. 
 
Inclination – The angle an orbital plane makes with Earth’s equatorial plane. 
 
Initial mass – The mass of the object at the beginning of the mission, including propellants. 
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Jansky – A unit of electromagnetic power density equal to 10-26 watts/m2/Hz. 
 
Launch (GUI) – An action within a GUI dialog causing an additional dialog to open for user 

application interface. 
 
Launch vehicle – Any space transportation mode, including expendable launch vehicles (ELVs), 

reusable launch vehicles (RLVs). 
 
Line of apsides – The line connecting the apogee and perigee points in an orbit. This line passes 

through the center of Earth. 
 
Line of nodes – The line formed by the intersection of the orbit plane with Earth’s equatorial plane. 

This line passes through the center of Earth. The ascending node is the point where a 
satellite crosses the equator from the southern hemisphere to the northern hemisphere. 

 
Low Earth Orbit (LEO) – An orbit with a mean altitude less than or equal to 2,000 km, or 

equivalently, an orbit with a period less than or equal to 127 minutes. 
 
Mean anomaly – An angle measure, the product of the orbiting object’s mean motion (mean angular 

rate) and the time since periapse passage. 
 
Medium Earth Orbit (MEO) – An orbit (or the region itself) between LEO and GEO. 
 
Meteoroids – Naturally occurring particles associated with solar system formation or evolution 

processes. Meteoroid material is often associated with asteroid breakup or material 
released from comets. 

 
Mission duration – The length of time that a mission is actively supported by ground operations. 
 
Near-GEO – An orbit that has low eccentricity and both the perigee and apogee points are within 

the altitude range of (GEO-500 km) and (GEO+300 km). 
 
NOAA – The National Oceanic and Atmospheric Administration, part of the U.S. Department of 

Commerce. NOAA’s Space Environment Center provides historical and predicted solar flux 
data. 

 
Operational orbit – The orbit of an object during its primary (and extended) missions. 
 
Orbital debris – Artificial objects, including derelict spacecraft and spent launch vehicle orbital 

stages, left in orbit, which no longer serve a useful purpose. In this document, only debris of 
diameter 1 mm and larger are considered. 

 
Orbital lifetime – The length of time an object remains in orbit. Objects in LEO or passing 

through LEO lose energy as they pass through Earth’s upper atmosphere, eventually 
getting low enough in altitude that the atmosphere removes them from orbit. 

 
Orbital stage – A part of the launch vehicle left in a parking, transfer, or final orbit during or after 

payload insertion; includes liquid propellant systems, solid rocket motors and any propulsive 
unit ejected from a spacecraft. 
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ORDEM – NASA’s Orbital Debris Engineering Model. This is a statistical model, based on 
observations, that describes the orbital debris environment between 200 and 2000 km 
altitude. DAS 3.2 uses ORDEM 3.2, which describes the orbital debris environment between 
the altitudes of 100 and 40,000 km. NOTE:  Increased fidelity of the ORDEM 3 comes at 
the cost of greatly-increased DAS run times. 

 
ORSAT – The Object Reentry Survival Analysis Tool, NASA’s computer code for predicting the 

reentry survivability of satellite and launch vehicle upper-stage components entering from 
orbital decay or from controlled entry. 

 
Penetration debris flux – The number of impacts per square meter per year that will penetrate a 

surface of specified orientation with specified materials and structural characteristics. 
 
Perigee – The point in the orbit that is nearest to the center of Earth. The perigee altitude is the 

distance of the perigee point above the surface of Earth. 
 
Postmission disposal (PMD) – The process of intentionally changing the orbit of a spacecraft after 

the end of the operational mission. 
 
Right ascension of ascending node – The angle between the line extending from the center of Earth 

to the ascending node of an orbit and the line extending from the center of Earth to the 
vernal equinox, measured from the vernal equinox eastward in Earth’s equatorial plane. 

 
Semi-major axis – Half the sum of the distances of apogee and perigee from the center of Earth (or 

other body); equal to half the length of the major axis of the elliptical orbit. 
 
Semi-synchronous Orbit– An orbit with approximately a 12-hour period. A circular semi-

synchronous is at an altitude of 20,200 km. 
 
Solar flux unit (sfu) – Equal to 104 janskys measured at a wavelength of 10.7 cm. 
 
Space debris – General class of debris, including both meteoroids and orbital debris. 
 
Stabilized – When the spacecraft maintains its orientation along one or more axes. 
 
Station-Keeping – During its mission duration, the payload is precluded from natural orbital decay 

by active station-keeping devices, e.g. thrusters. 
 
Thermal mass – The thermal mass is strictly the mass of one specific object. This is the mass used 

for determining how much material needs to burn up. 
 
Vernal equinox – The direction of the Sun in space when it passes from the southern hemisphere to 

the northern hemisphere (on March 20 or 21) and appears to cross Earth’s equator. The 
vernal equinox is the reference point for measuring angular distance along Earth’s 
equatorial plane (right ascension). It is one of two angles usually used to locate objects in 
orbit (the other being declination). 

 
Wet/Dry mass – Wet mass is the mass of an object (payload or orbital stage) including propellant or 

any other expendable fluid, while dry mass is the mass of an object less any expendables. 
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Appendix B: NASA Technical Standard 8719.14C Requirements 
 

4.3. ASSESSMENT OF DEBRIS RELEASED DURING NORMAL 

OPERATIONS 
 

 

Orbital debris analyses assess the amount of launch vehicle and spacecraft debris released during 

normal operations. This requirement area applies to all space structures while in Earth. Operators 

are encouraged to limit the release of debris while in Moon or Mars orbit, or in the vicinity of 

Sun-Earth or Earth-Moon Lagrange Points. 

4.3-1. Planned debris release passing through LEO – released debris with diameters of 1mm or larger:   
    

4.3-1a. All debris released during the deployment, operation, and disposal phases shall be limited 
to a maximum orbital lifetime of 25 years from date of release. 

 
4.3-1b. The total object-time product shall be less than 100 object-years per launch vehicle upper 

stage or per spacecraft.  
 
4.3-2. Planned debris release passing near GEO:   
   For missions leaving debris in orbits with the potential of traversing GEO (GEO altitude ± 200 km 

and ± 15 degrees inclination), released debris with diameters of 5 mm or greater shall be left in 
orbits which will ensure that within 25 years after release the apogee will no longer exceed GEO - 
200 km or the perigee will not be lower than GEO + 200 km, and also ensures that the debris is 
incapable of being perturbed to lie within that GEO ± 200 km and ± 15 zone for at least 100 years 
thereafter. 

 

 

 

NASA programs and projects assess and limit the amount of debris released as part of the mission.  

REQUIREMENTS 
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4.4. ASSESSMENT OF DEBRIS GENERATED BY EXPLOSIONS  

AND INTENTIONAL BREAKUPS 
 

 

Orbital debris analyses assess accidental explosion probability and intentional breakups during and 

after completion of mission operations. Section 4.4 is not intended to mandate the use of techniques 

that could cause unreasonable passivation errors or malfunctions that involve nonreversible 

passivation methods. 
 

 
4.4-1. Limiting the risk to other space systems from accidental explosions during deployment and mission 

operations while in orbit about Earth or the Moon:   
   For each spacecraft and launch vehicle orbital stage employed for a mission (i.e., every individual 

free-flying structural object), the program or project shall demonstrate, via failure mode and effects 
analyses, probabilistic risk assessments, or other appropriate analyses, that the integrated 
probability of explosion for all credible failure modes of each spacecraft and launch vehicle is less 
than 0.001 (excluding small particle impacts). 

 
4.4-2. Design for passivation after completion of mission operations while in orbit about Earth or the 

Moon:   
   Design of all spacecraft and launch vehicle orbital stages shall include the ability and a plan to 

either 1) deplete all onboard sources of stored energy and disconnect all energy generation sources 
when they are no longer required for mission operations or postmission disposal or 2) control to a 
level which cannot cause an explosion or deflagration large enough to release orbital debris or 
break up the spacecraft. The design of depletion burns and ventings should minimize the probability 
of accidental collision with tracked objects in space.  

 
 

NASA programs and projects assess and limit the effect of intentional breakups of spacecraft and 

launch vehicle orbital stages on other users of space. 

 
4.4-3. Limiting the long-term risk to other space systems from planned breakups for Earth and lunar 

missions: 
   Planned explosions or intentional collisions shall: 

a)  be conducted at an altitude such that for orbital debris fragments larger than 10 cm the object-
time product is less than 100 object-years. For example, if the debris fragments greater than 
10 cm decay in the maximum allowed 1 year, a maximum of 100 such fragments can be 
generated by the breakup. 

b)  not generate debris larger than 1 mm that remains in Earth orbit longer than one year. 
 

NASA programs and projects assess and limit the probability of accidental spacecraft and launch 

vehicle orbital stage explosion during and after completion of deployment and mission operations.  

REQUIREMENTS 

REQUIREMENTS 



 

B-3 

4.4-4. Limiting the short-term risk to other space systems from planned breakups for Earth orbital 
missions:  

   Immediately before a planned explosion or intentional collision, the probability of debris, orbital 
or ballistic, larger than 1 mm colliding with any operating spacecraft within 24 hours of the breakup 
shall be less than 10-6. 
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4.5. ASSESSMENT OF DEBRIS GENERATED BY  

ON-ORBIT COLLISIONS 
 

 

Orbital debris analyses assess the ability of the design and mission profile of a space system to limit 

the probability of accidental collision with known resident space objects during the system’s orbital 

lifetime. Requirement area 4.5 applies to all space structures in Earth orbit. 
 

NASA programs and projects assess and limit the probability that the operating space system 

becomes a source of debris if it collides with orbital debris or meteoroids. 
 

REQUIREMENTS 
 
4.5-1. Limiting debris generated by collisions with large objects when in Earth orbit:   
   For each spacecraft and launch vehicle orbital stage, the program or project shall demonstrate that, 

during the orbital lifetime of each spacecraft and orbital stage, the probability of accidental collision 
with space objects larger than 10 cm in diameter is less than 0.001. For the purpose of this 
assessment, 100 years is used as the maximum orbital lifetime for the storage disposal option. 

 
4.5-2. Limiting debris generated by collisions with small objects when operating in Earth orbit:  
  For each spacecraft, the program or project shall demonstrate that, during the mission of the 

spacecraft, the probability of accidental collision with orbital debris and meteoroids sufficient to 
prevent compliance with the applicable postmission disposal maneuver requirements is less than 
0.01.  
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4.6. POSTMISSION DISPOSAL OF SPACE STRUCTURES 
 

NASA space programs and projects are to plan for the disposal of a space structure (i.e., launch 

vehicle components, upper stages, spacecraft, and other payloads) at the end of their respective 

missions. Disposal can be accomplished by one of the following methods: (1) Earth atmospheric 

reentry, (2) direct reentry, (3) maneuvering to a storage orbit, (4) direct retrieval, (5) long-term 

reentry, or (6) Earth escape. Requirement area 4.6 applies to all space structures when in Earth 

orbit. 

REQUIREMENTS 
 
 
4.6-1. Natural reentry, direct reentry, or direct retrieval shall comply with the following: 

 
a. Natural reentry:  Leave the space structure in an orbit in which, using conservative projections 

for solar activity, atmospheric drag will limit the orbital lifetime to as short as 
practicable but no more than 25 years after the completion of mission. 

 
b. Direct reentry:  Maneuver the space structure into a controlled de-orbit trajectory as soon as 

practical after completion of mission. 
 
c. Direct retrieval:  Retrieve the space structure and remove it from orbit preferably at completion 

of mission, but no more than 5 years after completion of mission. 
 

4.6-2. Storage and Earth escape shall comply with the following:  

a. Storage between LEO and GEO: 

(1) Maneuver to a highly eccentric disposal orbit (e.g., GEO transfer orbit) where (i) perigee 

altitude remains above 2000 km for at least 100 years, (ii) apogee altitude remains below 35,586 

km for at least 100 years, and (iii) the time spent by the space structure between 20,182 +/- 300 

km is limited to 25 years or less over 200 years; or, 

(2) Maneuver to a near-circular disposal orbit to (i) avoid crossing 20,182 +/- 300 km, the GEO 

zone, and the LEO zone for at least 100 years, and (ii) limit the risk to other operational 

constellations, for example, by avoiding crossing the altitudes occupied by known missions of 10 

or more spacecraft using near-circular orbits, for 100 years. 

b. Storage above GEO:  Maneuver to a disposal orbit above GEO with a predicted minimum 

perigee of 35,986 km for a period of at least 100 years after disposal. 

c. Earth escape: Maneuver to a heliocentric, Earth-escape trajectory.  

 
4.6-3. Long-term reentry for space structures in Medium Earth Orbit (MEO), Tundra orbits, highly 

inclined GEO, and other orbits shall: 

a. Maneuver to a disposal orbit where orbital resonances will increase the eccentricity for long-

term reentry of the space structure,  

b. Limit the postmission orbital lifetime to as short as practicable but no more than 200 years,  
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c. Limit the time spent by the space structure in the LEO zone, the GEO zone, and between 20,182 

+/- 300 km to 25 years or less per zone, and  

d. Limit the probability of collisions with debris 10 cm and larger to less than 0.001 (1 in 1,000) 
during orbital lifetime 

 
4.6-4. Reliability of postmission disposal maneuver operations in Earth orbit:   
 NASA space programs and projects shall ensure that all postmission disposal operations to meet 

Requirements 4.6-1, 4.6-2, and 4.6-3 are designed for a probability of success as follows: 

 
a. Be no less than 0.90 at EOM, and 
 
b. For controlled reentry, the probability of success at the time of reentry burn must be sufficiently 

high so as not to cause a violation of Requirement 4.7-1 pertaining to limiting the risk of human 
casualty. 
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4.7. ASSESSMENT OF DEBRIS SURVIVING ATMOSPHERIC REENTRY  
 

 

Orbital debris analyses assess the risks associated with the disposal of a space vehicle in Earth’s 

atmosphere. Requirement area 4.7 applies to all spacecraft and launch vehicles returning to the 

surface of Earth from an altitude of greater than 130 km. 

 

NASA space programs and projects that use atmospheric reentry as a means of disposal for 

space structures need to limit the amount of debris that can survive reentry and pose a threat to 

people on the surface of the Earth. This area applies to full spacecraft as well as jettisoned 

components. 

 
4.7-1. Limit the risk of human casualty:   
 The potential for human casualty is assumed for any object with an impacting kinetic energy in 

excess of 15 joules.  
 

a. For uncontrolled reentry, the risk of human casualty from surviving debris shall be less than 
0.0001 (1:10,000). 

 
b. For controlled reentry, the selected trajectory shall ensure that no surviving debris impact with a 

kinetic energy greater than 15 joules is closer than 370 km from foreign landmasses, or is within 
50 km from the continental U.S., territories of the U.S., and the permanent ice pack of 
Antarctica. 

 
c. For controlled reentry, the product of the probability of failure to execute the reentry burn and 

the risk of human casualty assuming uncontrolled reentry shall be less than 0.0001 (1:10,000). 
 
d.  For long-term reentry of space structures in MEO, Tundra orbits, highly inclined GEO, and 

other orbits: Surviving debris shall have less than 7 m2 total debris casualty area or 0.0001 (1 in 
10,000) risk of human casualty. 

 

 

 

REQUIREMENTS 
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4.8. ADDITIONAL ASSESSMENT REQUIREMENTS FOR SPECIAL 

CLASSES OF SPACE MISSIONS  
 

 

The 2019 ODMSP includes a new section on certain special classes of space missions and 

establishes additional measures to mitigate the risk of debris generation from such missions. Those 

missions include (1) large constellations, (2) small satellites, including CubeSats, (3) rendezvous, 

proximity operations, and satellite servicing, (4) safety of active debris removal operations, and (5) 

tether systems. NASA programs or projects planning such missions shall meet the standard 

practices established in Objective 5 of the 2019 ODMSP. Due to the unique nature of large 

constellations and tether systems, please contact the NASA Orbital Debris Program Office for 

technical assistance to prepare ODAR and EOMP deliverables. The example below is an illustration 

of the complexities of the tether systems. 

 

Orbital debris analyses assess the potential hazard of tethered systems considering both an intact 

and a severed system. A tether is a long flexible structure greater than 300 meters in length. Tethers 

can have a variety of purposes, but are typically used electro-dynamically for power generation or 

to impart changes in linear or angular momentum. The potential to damage operating spacecraft can 

be larger than would be expected solely from the tether mass and cross-sectional area. Requirement 

area 4.8 applies to all space structures using tethers in Earth orbits. 

 

NASA programs and projects assess and limit the collision hazard posed by tether systems on 

other users of space and on the near-Earth environment. 

 
4.8-1. Special classes of space missions: Special classes of space missions, including large constellations; 

rendezvous, proximity operations, and satellite servicing; safety of active debris removal 
operations; tethers; and small satellites, shall comply with (1) the requirements in Sections 4.3 
through 4.7, (2) the applicable mitigation standard practices established in Objective 5 of the 2019 
ODMSP, and (3) the following:   

   a. Tether systems:  Intact and remnants of severed tether systems in Earth orbit shall limit the 
generation of orbital debris from on-orbit collisions with other operational spacecraft. Tether 
systems should generally not remain deployed after the completion of their mission objectives. 
After mission objectives are met, such tethers should have provisions for disposal (full 
retraction/stowing and/or removal from Earth orbit) with a >0.90 probability of success, including 
an assessment of the reliability of the disposal system and accounting for the possibility of damage 
to or cutting of the tether prior to disposal. 

 b. Small satellites, including CubeSats: For spacecraft smaller than 10 cm × 10 cm × 10 cm 
when fully deployed: 

   (1) Any spacecraft in LEO shall be limited to an orbital lifetime as short as practicable but 
no more than 25 years after completion of mission. 

   (2) The total spacecraft object-time product in LEO shall be less than 100 object-years per 
mission. 

REQUIREMENTS 
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Appendix C: DAS Technical Notes 
 

 

C.1 Orbit Propagators 

 

DAS 3 uses the NASA propagators “PROP3D” and “GEOPROP”. GEOPROP calculates the motion 

of objects in GEO, while PROP3D calculates the orbits of all other objects. A geosynchronous orbit 

is defined as having orbital eccentricity less than 0.1 and period between 0.95 and 1.05 days. The 

propagators are designed to maintain integration accuracy over long propagation periods (decades) 

with reasonable computation speed. 

 

Both propagators account for all significant perturbing forces. Table C-1 lists the perturbations and 

some of the reference models used. PROP3D propagates five orbital elements, describing the shape 

and orientation of the orbit, but not the position of the object along that orbit. GEOPROP 

propagates all six orbital elements, based on the disturbing-function formulation of Van der Ha [1]. 

 

Table C-1: Perturbations included in the DAS Orbit Propagators 

Perturbation PROP3D GEOPROP 

Atmospheric drag Oblate, rotating 

atmosphere [2, 3] 

None 

Solar & Lunar gravity Yes [4] Yes 

Solar radiation pressure (SRP) Yes Yes 

Earth’s shadow for SRP Yes Neglected 

Earth’s gravity field Zonal harmonics: J2, J3, 

J4, (J2)
2   [5] 

Zonal harmonics: J2, J3, J4 

Tesseral harmonics: J2,2, J3,1, 

J3,3, J4,2, J4,4 

 

For DAS 3, the coefficient of drag is assumed to be 2.2. The coefficient of reflectivity (for the solar 

radiation pressure perturbation) is assumed to be 1.0. For reference, a perfectly transparent object 

would have a coefficient of reflectivity of zero, while a planar mirror normal to the (solar) flux 

would have a coefficient of 2.0. 

 

 

1. Van der Ha, J.C., “Long-term evolution of near-geo orbits,” J. Guidance, 9, p. 363-370, 1986. 

2. Jacchia, L.G., Thermospheric Temperature, Density and Composition: New Models, Smithsonian 

Astrophysical Observatory, Special Report 375, 1977. 

3. King-Hele, D., Satellite Orbits in an Atmosphere, Blackie & Son, LTD., London, 1987. 

4. Cook, G.E., “Luni-solar perturbations of the orbit of an Earth satellite,” The Geophysical Journal 

of the Royal Astronomical Society, 6, p. 271-291, 1962. 

5. Vallado, D.A., Fundamentals of Astrodynamics and Applications, McGraw-Hill, NY, 1997. 
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C.2 Orbital Elements 

 

Orbital elements are mathematical quantities used to describe the path (trajectory) of an object 

traveling through space. DAS uses a set of Keplerian mean orbital elements. Figures C-1 and C-2 

depict the physical nature of the elements, which are listed in Table C-2. One common format of the 

orbital elements is the TLE format, described in Sect. 4.6.1 of this Guide. For more information, the 

reader should consult any basic celestial mechanics textbook. 

 

 

Figure C-1: Orbital Elements in the Orbital Plane 
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Figure C-2: Orbital Elements 

 

Table C-2: Description of the Orbital Elements 

Orbital Element Symbol Description 

Semi-major axis a Half the sum of the distances of apogee and perigee 

from the center of Earth. Half the length of the major 

axis of the elliptical orbit. 

Eccentricity e A measure of an orbit’s ellipticity, calculated as the 

orbit’s apogee altitude minus its perigee altitude, 

divided by twice its semi-major axis. 

Inclination i The angle an orbital plane makes with Earth’s 

equatorial plane. 

RAAN Ω The angle between the line extending from the center 

of Earth to the ascending node of an orbit and the 

line extending from the center of Earth to the vernal 

equinox, measured from the vernal equinox eastward 

in Earth’s equatorial plane. 

Argument of perigee ω The angle between the line extending from the center 

of Earth to the ascending node of an orbit and the 

line extending from the center of Earth to the perigee 

point in the orbit, measured from the ascending node 

in the direction of motion of the satellite. 

Mean anomaly 

(not pictured) 

M An angle measure: the product of the orbiting 

object’s mean motion (mean angular rate) and the 

time since periapse passage. 
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C.3 Orbital Debris Environment Model 

 

DAS incorporates ORDEM, which is also developed by the NASA Orbital Debris Program Office. 

Because DAS performs an ORDEM analysis for each year an object is in orbit, the underlying 

ORDEM runtimes are multiplied. Highly elliptical orbits, crossing a wider parameter space, will see 

the greatest increase in runtime. 

 

ORDEM 3.2 contains updated debris populations covering LEO (up to 2000 km altitude) to GEO 

(up to 40,000 km altitude) and can assess debris calculations (debris sizes greater than 10μm) up to 

year 2050, extending coverage past the previous limit of 2035 in ORDEM 3.0. In DAS, the time 

period is extended to year 2130. However, years 2051 through 2130 do not include small debris 

populations (i.e., sizes below 10 cm). An important result of this is that DAS cannot assess 

Requirement 4.5-2 for missions operating after 2050. This limitation is typically overcome by 

the ORDEM software release cadence. 

 

Two DAS Assessments use functions derived from ORDEM. The increase in run-time depends on 

the number of times DAS must call the ORDEM functions. 

 

Table C-3: DAS Functions that use ORDEM 

DAS function Number of times ORDEM routines are called 

Assessment of Requirement 4.5-1: 

Limiting Debris Generated by Collisions 

with Large Objects 

Once for every calendar year in orbit (not just 

mission lifetime) 

[orbital lifetime × 1] 

Assessment of Requirement 4.5-2: 

Probability of Damage from Small Debris 

Once for every calendar year of mission 

lifetime 

[mission lifetime × 1] 

 

 

For further details and references, please see: 

 

 

“Orbital Debris Engineering Model 3.2 Release,” ODQN 26-1, March 2022. 

https://ntrs.nasa.gov/citations/20220004138 (retrieved 27 January 2026) 

 

 

Orbital Debris Engineering Models (ORDEM 3.2),  

https://www.orbitaldebris.jsc.nasa.gov/modeling/ordem.html (retrieved 27 January 2026). 

 

NASA Orbital Debris Engineering Model ORDEM 3.2 – Software User Guide, NASA/TP-

20230014989, NASA Orbital Debris Program Office, NASA-JSC, Houston, TX, USA, October 

2023. 

https://ntrs.nasa.gov/citations/20230014989 (retrieved 27 January 2026) 

 

https://ntrs.nasa.gov/citations/20220004138
https://ntrs.nasa.gov/citations/20230014989
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C.4 Solar Flux Model 

 

The value of the solar flux at a wavelength of 10.7 cm (2800 MHz), often called the F10.7 value, is 

used as a measure of solar activity. In DAS, the F10.7 value is used to compute the temperature, and 

therefore density, of Earth’s upper atmosphere. The user enters a starting date and a mission length, 

and the software looks up the appropriate F10.7 values in an included data table. The table includes 

historical values archived by the U.S. National Oceanic and Atmospheric Administration’s (NOAA) 

Space Weather Prediction Center (SWPC) (https://www.swpc.noaa.gov), as well as the SWPC’s 

“near-term” predictions. For epochs beyond the near term, a curve-fit technique using sixth-order 

sine and cosine terms was performed to fit historical daily solar flux values from 1947 through the 

end of the daily solar flux data available from NOAA. This curve-fit equation was then used to 

generate future flux predictions. 

 

The DAS solar flux input table is updated periodically. The updated file should be downloaded 

from the NASA Orbital Debris Program Office website and placed in the DAS “data” directory. 

 

For further information, see: 

 

Whitlock, D.O., “Modeling the Effect of High Solar Activity on the Orbital Debris Environment,” 

NASA Orbital Debris Quarterly News, vol. 10, no. 2, p. 4, April 2006. 

(https://orbitaldebris.jsc.nasa.gov/quarterly-news/newsletter.html) 

Manis, A., and Matney, M., “Updated Solar Cycle Predictions for Orbital Debris Modeling,” NASA 

Orbital Debris Quarterly News, vol. 24, no. 4, p. 4, November 2020. 

(https://orbitaldebris.jsc.nasa.gov/quarterly-news/newsletter.html) 

  

 

C.5 Human Casualty Expectation 

 

Human casualty expectation is the product of the population density and the computed debris 

casualty area. The probability of a surviving debris object striking a person on the ground is defined 

as the reciprocal of the casualty expectation. Since DAS is typically concerned with objects 

reentering years or even decades in the future, the population density must be treated statistically. 

Therefore, the population density is averaged over longitude, and the population density along an 

object’s ground-track is a function of its orbit inclination. The computed casualty area is a function 

of the debris size and the size of an “average” person. 

 

For further details and references, please see: 

 

Opiela, J.N., and M.J. Matney, “Improvements to NASA's Estimation of Ground Casualties from 

Reentering Space Objects,” Space Debris and Space Traffic Management Symposium, AAS 

Science and Technology Series, vol. 109, p. 385-392, 2004. 

Ostrom, C.L., “Improving Estimation of Ground Casualty Risk from Reentering Space Objects,” 9th 

International Association for the Advancement of Space Safety Conference, Toulouse, 2017. 

 

  

https://orbitaldebris.jsc.nasa.gov/quarterly-news/newsletter.html
https://orbitaldebris.jsc.nasa.gov/quarterly-news/newsletter.html
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C.6 Properties of the Default Materials 

 

DAS includes a built-in list of the most common materials used in space vehicles. Three material 

properties are used in assessment of an object’s reentry survivability:  specific heat, heat of fusion, 

and melt temperature. DAS also uses mass density to make sure a component’s mass and size are 

consistent. The properties of the DAS built-in materials are listed in the table below. Note that the 

specific heat of many of the materials is a function of the materials’ temperature. 

 

Table C-4: Properties of DAS 3 Built-In Materials 

Material Description Specific Heat 
(J/kg-K) 

Heat of 
Fusion 
(J/kg) 

Melt 
Temper-
ature (K) 

Density 
(kg/m3) 

Acrylic 1465 0.0 505.0 1170.00 

Alumina  694.0 < Cp < 1219.0 106757.0 2305.4 3990.00 

Aluminum (generic) 1100 390000.0 850.0 2700.00 

Aluminum 1145-H19 904 386116.0 919.0 2697.00 

Aluminum 2024 - T3 972.7 386116.0 856.0 2803.20 

Aluminum 2024-T8xx  600.0 < Cp < 1100.0 386116.0 856.0 2803.00 

Aluminum 2219-T8xx  864.5 < Cp < 981.6 386116.0 867.0 2812.80 

Aluminum 5052 900.2 386116.0 880.0 2684.90 

Aluminum 6061-T6 896 386116.0 867.0 2707.00 

Aluminum 7075-T6  650.7 < Cp < 1177.9 376788.0 830.0 2787.00 

Barium element 285 55824.0 983.0 3492.00 

Beryllium element 1203.0 < Cp < 3595.0 1093220.0 1557.0 1842.00 

Beta cloth 837.5 232.6 650.0 1581.00 

Brass, Red            (85% Cu, 15% Zn)  397.7 < Cp < 410.3 195372.0 1280.0 8746.00 

Brass, Cartridge    (70% Cu, 30%Zn)  397.7 < Cp < 414.5 179091.0 1208.0 8521.80 

Brass, Muntz         (60% Cu, 40% Zn)  397.7 < Cp < 427.0 167461.0 1174.0 8393.67 

Carbon-Carbon Reinforced  707.0 < Cp < 1719.0 37650.0 2144.0 1688.47 

Cobalt  313.6 < Cp < 690.0 259600.0 1768.0 8862.00 

Cork 1629.2 2860980.0 922.0 261.29 

Cu alloy  385.0 < Cp < 472.0 204921.0 1356.0 8938.00 

Cu/ Be (0.5% Beryllium) 397 204921.0 1320.0 8800.00 

Cu/ Be (1.9% Beryllium)  460.5 < Cp < 652.0 204921.0 1199.0 8248.60 

Fiberfrax 1130.5 0.0 2089.0 96.10 

Fiberglass 1046.8 232.6 1200.0 1840.35 

FRCI-12 (also LI-2200 w/ diff rho) shuttle tiles  293.0 < Cp < 1268.0 0.0 1922.0 192.22 

Gallium Arsenide (GaAs) 325 0.0 1510.0 5316.00 

Germanium  314.1 < Cp < 397.7 430282.6 1210.7 5320.00 

Gold element  126.0 < Cp < 153.0 64895.0 1336.0 19300.00 

Graphite epoxy 1 879 232.6 700.0 1550.50 
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Table C-4: Continued 

Material Description Specific Heat 
(J/kg-K) 

Heat of 
Fusion 

(J/kg) 

Melt 
Temper-
ature (K) 

Density 
(kg/m3) 

Graphite epoxy 2 879 232.6 700.0 1550.50 

Hastelloy c     (57% Ni, 15% Cr, 15% Mo, 5% Fe, 
4% W) 

 498.4 < Cp <  693.7 309803.0 1620.0 8920.67 

Hastelloy 25   (aka Haynes alloy 25, 51% Co, 
20% Cr, 10% Ni, 15% W) 

 403.0 < Cp <  590.0 309803.0 1643.0 9130.00 

Hastelloy 188 (aka Haynes alloy 188, 42% Co, 
22% Cr, 22% Ni, 14% W) 

 403.0 < Cp <  590.0 309803.0 1635.0 8980.00 

Hastelloy n     ( 71% Ni, 7% Cr, 16% Mo, 55% Fe)  419.0 < Cp <  578.0 309803.0 1623.0 8576.40 

Inconel x        (aka x-750, Ni > 70%, 15% Cr, 7% 
Fe) 

 341.4 < Cp <  541.8 311664.0 1683.2 8297.50 

Inconel 600    (Ni >72%, 15% Cr, 18% Fe)  412.6 < Cp <  650.2 297206.0 1683.9 8415.00 

Inconel 601    (Ni 60%, 23% Cr, 13% Fe)  412.6 < Cp <  650.2 311664.0 1659.0 8057.29 

Inconel 625    (Ni >58%, 21% Cr, 9% Mo, 3% Nb) 410 311664.0 1593.0 8440.00 

Inconel 718    (Ni 53%, 19% Cr, 17% Fe) 435 311664.0 1571.0 8190.00 

Invar  500.0 < Cp <  653.2 274000.0 1700.0 8050.00 

Iron (Armco)  307.0 < Cp <  709.0 272125.0 1812.0 7865.00 

Lead element  130.5 < Cp <  138.8 23958.0 600.0 11677.00 

Macor ceramic 790 236850.0 1300.0 2520.00 

Magnesium AZ31      (3% Al, 1% Zn) 1008.0 < Cp < 1398.0 339574.0 868.0 1682.00 

Magnesium HK31A    (3% Th, 1% Zr) 1019.2 < Cp < 1340.6 325619.0 877.0 1794.00 

Molybdenum  246.0 < Cp <  412.0 293057.0 2899.0 10219.00 

MLI 1046.6 232.6 617.0 772.48 

MP35N       (35% Ni, 33% Co, 20% Cr, 10% Mo) 333.34 < Cp <  
622.15 

309803.0 1650.0 8430.00 

Nickel  333.34 < Cp <  
622.15 

309803.0 1728.2 8906.26 

Niobium (a.k.a. columbium)  270 < Cp <  345.0 290000.0 2741.0 8570.00 

NOMEX 1256 232.6 572.0 1380.00 

Platinum  129.0 < Cp <  146.0 113967.0 2046.4 21448.70 

Polyimide 1130 232.6 723.0 1420.00 

Polycarbonate (Lexan) 1260 0.0 573.0 1250.00 

RCG Coating  627.0 < Cp < 1633.0 0.0 1922.0 1665.91 

Rene41         (52% Ni, 19% Cr, 11% Co, 10% Mo)  346.9 < Cp <  914.9 311664.0 1728.0 8249.00 

Silver element  222.5 < Cp <  243.0 105833.0 1234.0 10492.00 

Sodium-Iodide 84 290759.6 924.0 3470.00 

Stainless Steel (generic) 600 270000.0 1700.0 7800.00 

Steel 17-4 ph   (Precipitation Hardening SS, Fe + 
17%Cr + 4%Ni+ 3-4%Cu alloy) 

666.8 286098.0 1728.0 7833.03 

Steel 21-6-9     (Stainless Steel, 64%Fe+ 21% Cr+ 
6% Ni+ 9% Mn  alloy) 

439 286098.0 1728.0 7832.80 

Steel A-286      (Stainless Steel, 60% Fe + 15% Cr 
+ 25% Ni alloy) 

460.6 286098.0 1644.0 7944.90 
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Table C-4: Concluded 

Material Description Specific Heat 
(J/kg-K) 

Heat of 
Fusion 

(J/kg) 

Melt 
Temper-
ature (K) 

Density 
(kg/m3) 

Steel AISI 304  (Stainless Steel, 69% Fe + 19% 
Cr + 10% Ni alloy) 

 482.0 < Cp <  608.0 286098.0 1700.0 7900.00 

Steel AISI 316  (Stainless Steel, 62% Fe + 18% 
Cr + 14% Ni alloy) 

460.6 286098.0 1644.0 8026.85 

Steel AISI 321  (Stainless Steel, 69% Fe + 17% 
Cr + 11% Ni alloy) 

 565.2 < Cp <  651.2 286098.0 1672.0 8026.60 

Steel AISI 347  (Stainless Steel, 68% Fe + 17% 
Cr + 11% Ni alloy) 

 462.0 < Cp <  638.0 286098.0 1686.0 7960.00 

Steel AISI 410  (Stainless Steel, 86% Fe + 13% 
Cr alloy) 

485.7 286098.0 1756.0 7749.50 

Strontium element 737 95599.0 1043.0 2595.00 

Teflon 1674 0.0 533.0 2162.50 

Titanium (generic) 600 470000.0 1950.0 4400.00 

Titanium (6 Al-4 V)  450.0 < Cp < 1110.0 393559.0 1943.0 4437.00 

Tungsten  127.0 < Cp <  187.6 220040.0 3650.0 19300.00 

Uranium  115.0 < Cp <  178.5 52523.0 1405.0 19099.00 

Uranium Zirconium Hydride (UZrH) 418.7 131419.0 2144.0 6086.80 

Water 4300.0 < Cp < 6900.0 0.1 370.0 999.00 

Zerodur  800.0 < Cp < 1600.0 250000.0 1424.0 2530.00 

Zinc  372.0 < Cp <  444.0 100942.0 692.6 7144.20 

Aluminum 2195 (Al-Li) 167.0 < Cp < 1088.0 386116.0 878.0 2700.0 

Aluminum 2090 209.0 < Cp < 1109.0 386116.0 878.0 2574.2 

A356 1109.0 389000.0 858.0 2691 

Nextel 741.1 233.0 2073.0 2700 

Kevlar 340.0 0.0 763.0 1206.0 
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Appendix D: DAS Python Scripting API 
 

Several Python scripts are provided for automating certain modeling tasks without the need for 

entering data through the graphical interface. These scripts connect directly to the DAS dynamic-link 

library (dll) using Python’s ctypes library. Python is an interpreted programming language that is 

easy to learn. More information is available from the Python Software Foundation 

(www.python.org). DAS Python scripting requires a Python interpreter of version 3.7 or later. Earlier 

versions may work but have not been tested. The DAS installed sample project folder includes 

examples of Python script files that demonstrate how to call the DAS functions from Python using 

the ctypes library with example data. The user may modify these scripts to suit their needs or write 

their own.  

 

The following functions are available for Python automation: 

• Apogee/perigee history 

• Large object collision probability 

• Small object collision probability 

• Orbit lifetime 

• Reentry human casualty risk 

• Post-mission disposal assessment 

• Cross-sectional area calculations 

 

D.1 Basic Usage 

 

The example scripts have been written such that a user may add their own code to a copy of the 

script to supply their desired data to the function, add the example script to a project directory and 

use Python’s import statement to call the function in their project, or use the example script as a 

guide for writing their own functions to call the DAS subroutines. To confirm that the scripts are 

working properly, their results may be compared to the output from the DAS graphical interface 

using the same input values. 

 

To use one of the example scripts, the user must provide the ctypes library with the path to the 

Fortran.dll file located in the root directory of your DAS installation folder (typically located in the 

"\Local\NASA\” directory in the user’s home folder. This is done at the beginning of each script in 

the statement: 

 
flib = ct.CDLL(“path/to/Fortran.dll”) 

 

When using the function in the script, note the listed input and output variables including their units, 

data types, and size (if applicable). These are listed below, as well as at the top of each example 

script file. Make sure the correct data types and values are supplied to the function: 

• Note (if applicable) that strTmpPath should be the path to the project folder of the DAS 

installation, and ilenTmpPath should equal the length of that address.  

• For arrays, use the Python numpy library and ensure that the value for the array order is 

set to ‘F’.  

• For scalar values and strings, the appropriate regular Python types may be supplied. 
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D.2 Python Function Descriptions 

 

APOPERIHIST 

Runs the apogee/perigee altitude history utility. Propagates the given orbital elements for the given 

duration and outputs the periapsis altitude and apoapsis altitude histories for the propagation 

duration. 
Table D–1: APOPERIHIST Input Values 

Input name Python 

type(s) 

ctype Fortran type Description 

startyr float c_double real(8) starting year 

duration float c_double real(8) duration of propagation (yrs) 

hperi float c_double real(8) periapsis altitude (km) 

hapo float c_double real(8) apoapsis altitude (km) 

inc float c_double real(8) orbit inclination (deg) 

RAAN float c_double real(8) right ascension of ascending node (deg) 

argperi float c_double real(8) argument of periapsis (deg) 

mean_anom float c_double real(8) mean anomaly (deg) 

aom float c_double real(8) area to mass ratio 
 

 

Table D–2: APOPERIHIST Output Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

yr_hist numpy array c_double real(8) year of each time step 

hperi_hist numpy array c_double real(8) periapsis altitude at each time step (km) 

hapo_hist numpy array c_double real(8) apoapsis altitude at each time step (km) 

numpoints int c_int integer(4) number of data points in output 
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COLL_LARGEOBJ 

Runs the large-object collision probability requirement assessment using the given spacecraft and 

orbit inputs. 

 
Table D–3: COLL_LARGEOBJ Input Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

strTmpPath str c_char_p character(*) project folder file path 

hperi float c_double real(8) periapsis altitude (km) 

hapo float c_double real(8) apoapsis altitude (km) 

inc float c_double real(8) orbit inclination (deg) 

RAAN float c_double real(8) right ascension of ascending node (deg) 

argperi float c_double real(8) argument of periapsis (deg) 

mean_anom float c_double real(8) mean anomaly (deg) 

aom_eol float c_double real(8) area to mass ratio at end of life 

startyr float c_double real(8) beginning fractional year (YYYY.Y) 

mass_bol float c_double real(8) mass at beginning of life (kg) 

mass_eol float c_double real(8) mass at end of life (kg) 

duration float c_double real(8) length of mission, not including PMD (yrs) 

statkept bool c_ubyte logical object is station-kept during this phase 

abandoned bool c_ubyte logical object is abandoned in place at EOM 

LTReentry bool c_ubyte logical user selected long-term (resonance) reentry 

hperi_pmd float c_double real(8) post-mission disposal perigee altitude (km) 

hapo_pmd float c_double real(8) PMD apogee altitude (km) 

inc_pmd float c_double real(8) PMD inclination (deg) 

RAAN_pmd float c_double real(8) PMD right ascension of ascending node 

(deg) 

argperi_pmd float c_double real(8) PMD argument of perigee (deg) 

mean_anom_pmd float c_double real(8) PMD mean anomaly (deg) 

ilenTmpPath int c_int integer(4) length of strTmpPath 
 

 

Table D–4: COLL_LARGEOBJ Output Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

collprob float c_double real(8) total collision probability 

passed bool c_ubyte logical requirement passed 

IMSG1_collarge int c_int integer(4) error message code 

IMSG2_collarge int c_int integer(4) ORDEM date-range message code 
 

 

Table D–5: IMSG1_Collarge Interpretation Table 

Value Message 

0 no message 

2 failed assessment, probability of collision too great 

1,3-5  Various error codes; report to ODPO if these arise 
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Table D–6: IMSG2_Collarge Interpretation Table 

Value Message 

0 no message (mission is entirely within ORDEM date range) 

1 begin date is before ORDEM begin date 

2 end date is after ORDEM end date 

3 outside both ORDEM begin and end 

4 begin and end before ORDEM begin 

5 begin and end after ORDEM end 
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COLL_SMALLOBJ 

Runs the small-object collision probability requirement assessment using the given spacecraft and 

orbit inputs. 

 
Table D–7: COLL_SMALLOBJ Input Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

strTmpPath str c_char_p character(*) project folder file path 

hperi float c_double real(8) periapsis altitude (km) 

hapo float c_double real(8) apoapsis altitude (km) 

inc float c_double real(8) orbit inclination (deg) 

RAAN float c_double real(8) right ascension of ascending node (deg) 

argperi float c_double real(8) argument of periapsis (deg) 

mean_anom float c_double real(8) mean anomaly (deg) 

aom_eol float c_double real(8) area to mass ratio at end of life 

statkept bool c_ubyte logical object is station-kept during this phase 

startyr float c_double real(8) beginning fractional year (YYYY.Y) 

duration float c_double real(8) length of mission, not including PMD 

(yrs) 

orient int c_int integer(4) object orientation flag: 1 - random, 2 - 

oriented, 3 - gravity-gradient 

numsurf int c_int integer(4) number of critical surfaces 

bwdensity float c_double real(8) areal density of the back wall (g/cm²) 

press bool c_ubyte logical back wall is a pressure vessel 

sarea float c_double real(8) area of the critical surface (m²) 

normvec numpy array c_double real(8), 

dimension(3) 

unit normal vector of the surface in 

spacecraft coordinates (UVW) 

numlayers int c_int integer(4) number of walls in each surface 

ldensity float c_double real(8) areal density of each bumper layer 

(g/cm²) 

sepdist float c_double real(8) distance between each layer and the back 

wall (cm) 

ilenTmpPath int c_int integer(4) length of strTmpPath 
 

 

Table D–8: COLL_SMALLOBJ Output Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

probpenet float c_double real(8) penetration probability 

IMSG1_collsmall int c_int integer(4) error message code 

IMSG2_collsmall int c_int integer(4) ORDEM date-range message code 
 

 

Table D–9: IMSG1_Collsmall Interpretation Table 

Value Message 

0 no message 

2 failed assessment, probability of collision too great 

1,3-8 Various error codes; report to ODPO if these arise 
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Table D–10: IMSG2_Collsmall Interpretation Table 

Value Message 

0 no message (mission is entirely within ORDEM date range) 

1 begin date is before ORDEM begin date  

2 end date is after ORDEM end date  

3 outside both ORDEM begin and end 

4 begin and end before ORDEM begin 

5 begin and end after ORDEM end 
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LIFEDWELL 

Runs the orbit lifetime/dwell time utility. Determines the orbit lifetime of an object with the given 

area-to-mass ratio in the given starting orbit and outputs the lifetime in years, the cumulative years 

spent in LEO, the last year of propagation, and whether the object reentered. 

 
Table D–11: LIFEDWELL Input Values 

Input name Python 

type(s) 

ctype Fortran type Description 

startyr float c_double real(8) starting year 

hperi float c_double real(8) periapsis altitude (km) 

hapo float c_double real(8) apoapsis altitude (km) 

inc float c_double real(8) orbit inclination (deg) 

RAAN float c_double real(8) right ascension of ascending node (deg) 

argperi float c_double real(8) argument of periapsis (deg) 

aom float c_double real(8) area to mass ratio 
 

 

Table D–12: LIFEDWELL Output Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

lifetime float c_double real(8) Total orbit lifetime from startyr (yrs) 

dwelltime float c_double real(8) cumulative LEO dwell time (yrs) 

lastyear float c_double real(8) final year of propagation 

IMSG_lifedwell int c_int integer(4) message code 
 

 

LL 

Table D–13: IMSG_Lifedwell Interpretation Table 

Value Message 

0 no message 

1 Object will remain in orbit and above LEO for the foreseeable future (> 100 years). The 

orbit is NOT processed 

2 Object reentered 

3 Object did not reenter within MAXPROPYRS 
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MORSAT 

Runs the reentry human casualty risk assessment for the given spacecraft and outputs the demise 

altitude, debris casualty area (DCA), and impact kinetic energy for each component, the expectation 

of casualty (𝐸𝑐) for each parent object, and the total DCA. 

 
Table D–14: MORSAT Input Values 

Input name Python 

type(s) 

ctype Fortran type Description 

strTmpPath str c_char_p character(*) project folder file path 

inc float c_double real(8) orbit inclination angle (deg) 

ncomp int c_int integer(4) total number of components 

parent numpy 

array 

c_int integer(4), 

dimension(ncomp) 

the row number of the parent object of 

each object 

qty numpy 

array 

c_int integer(4), 

dimension(ncomp) 

quantity of each object 

imat numpy 

array 

c_int integer(4), 

dimension(ncomp) 

material ID # for each object 

itype numpy 

array 

c_int integer(4), 

dimension(ncomp) 

shape type for each object: 1- sphere, 2 – 

cylinder, 3 – flat plate, 4 – box  

amass numpy 

array 

c_double real(8), 

dimension(ncomp) 

aerodynamic mass for each object 

shape numpy 

array 

c_double real(8), 

dimension(ncomp,4) 

modeling parameters for each object 

where shape(i, 1) is thermal mass (kg), 

shape(i,2) is diameter/width (m), 

shape(i,3) is length (m), and shape(i,4) is 

height (m) 

entryYear int c_int integer(4) entry year 

ilenTmpPath int c_int integer(4) length of strTmpPath 
 

 

Table D–15: MORSAT Output Values 

Input 

name 

Python type(s) ctype Fortran type Description 

hd numpy array c_double real(8), 

dimension(ncomp) 

demise altitude for each object 

(km) 

dca numpy array c_double real(8), 

dimension(ncomp) 

debris casualty area for each 

object (m²) 

KE numpy array c_double real(8), 

dimension(ncomp) 

impact kinetic energy of each 

object (J) 

Ec float c_double real(8) expectation of casualty for the 

parent object 

sumdca float c_double real(8) Total DCA for all objects 
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PMD 

Runs the postmission disposal requirement assessment on the given satellite and orbit parameters. 

 
Table D–16: PMD Input Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

hperi float c_double real(8) periapsis altitude (km) 

hapo float c_double real(8) apoapsis altitude (km) 

inc float c_double real(8) orbit inclination (deg) 

RAAN float c_double real(8) right ascension of ascending node (deg) 

argperi float c_double real(8) argument of periapsis (deg) 

mean_anom float c_double real(8) mean anomaly (deg) 

aom_eol float c_double real(8) area to mass ratio at end of life 

startyr float c_double real(8) beginning fractional year (YYYY.Y) 

mass_bol float c_double real(8) mass at beginning of life (kg) 

mass_eol float c_double real(8) mass at end of life (kg) 

duration float c_double real(8) length of mission, not including PMD 

(yrs) 

statkept bool c_ubyte logical object is station-kept during this phase 

abandoned bool c_ubyte logical object is abandoned in place at EOM 

LTReentry bool c_ubyte logical user selected long-term (resonance) 

reentry 

hperi_pmd float c_double real(8) post-mission disposal perigee altitude 

(km) 

hapo_pmd float c_double real(8) PMD apogee altitude (km) 

inc_pmd float c_double real(8) PMD inclination (deg) 

RAAN_pmd float c_double real(8) PMD right ascension of ascending node 

(deg) 

argperi_pmd float c_double real(8) PMD argument of perigee (deg) 

mean_anom_pmd float c_double real(8) PMD mean anomaly (deg) 
 

 

Table D–17: PMD Output values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

inoteyr int c_int integer(4) year of reentry or PMD failure 

iguideline int c_int integer(4) requirement applied to the input 

object, based on the EOM orbit 

before PMD: 61 – Requirement 4.6-

1, 62 – Requirement 4.6-2, 63 – 

Requirement 4.6-3 

passed logical c_ubyte logical object passed assessment 

hperi_sugg float c_double real(8) suggested perigee altitude, if run 

failed (km) 

hapo_sugg float c_double real(8) suggested apogee altitude, if run 

failed (km) 

IMSG_pmd int c_int integer(4) message code 
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SUB_AREA 

Runs the cross-sectional area estimation utility. Calculates the cross-sectional area of the object 

defined by the provided triangle surfaces, cylinders, and spheres. 

 
Table D–18: PMD Input Values 

Input name Python 

type(s) 

ctype Fortran type Description 

strTmpPath str c_char_p character(*) project folder file path 

orient int c_int integer(4) object orientation flag: 1 - random, 2 

- oriented, 3 - gravity-gradient 

ntri int c_int integer(4) number of triangles 

ncyl int c_int integer(4) number of cylinders 

nsph int c_int integer(4) number of spheres 

xtri numpy 

array 

c_double real(8), 

dimension(3,ntri) 

x values for each vertex of each 

triangle (m) 

ytri numpy 

array 

c_double real(8), 

dimension(3,ntri) 

y values for each vertex of each 

triangle (m) 

ztri numpy 

array 

c_double real(8), 

dimension(2,ntri) 

z values for each vertex of each 

triangle (m) 

xcyl numpy 

array 

c_double real(8), 

dimension(2,ncyl) 

x values for each end of each 

cylinder (m) 

ycyl numpy 

array 

c_double real(8), 

dimension(2,ncyl) 

y values for each end of each 

cylinder (m) 

zcyl numpy 

array 

c_double real(8), 

dimension(2,ncyl) 

z values for each end of each cylinder 

(m) 

xsph numpy 

array 

c_double real(8), 

dimension(1,nsph) 

x values for the center of each sphere 

(m) 

ysph numpy 

array 

c_double real(8), 

dimension(1,nsph) 

y values for the center of each sphere 

(m) 

zsph numpy 

array 

c_double real(8), 

dimension(1,nsph) 

z values for the center of each sphere 

(m) 

rcyl numpy 

array 

c_double real(8), 

dimension(2,ncyl) 

radius of each end of each cylinder 

(m) 

rsph numpy 

array 

c_double real(8), 

dimension(1,nsph) 

radius of each sphere (m) 

KillThread int c_int integer(4) kill thread 

ilenTmpPath int c_int integer(4) length of strTmpPath 
 

 

Table D–19: PMD Output Values 

Input name Python 

type(s) 

ctype Fortran 

type 

Description 

area float c_double real(8) cross-sectional area (m²) 

 
 


